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Impress est le module de PréAO de la suite
bureautique OpenOffice. Il permet de présenter
des projets, des produits et méme de dispenser
des formations a l'aide de diaporamas.

1.1. A propos de ce document

Ce document décrit I'utilisation, sous Windows, du
module Impress, le composant de PréAO
(Présentation assistée par ordinateur) de la suite
bureautique OpenOffice.

Il est principalement axé sur la suite bureautique
Apache OpenOffice™ (AOO) mais reste
également utilisable pour les suites bureautiques
allégées que sont OOo04Kids et OOolLight,
produites par l'association Educoo.org.

OOoLight et 0004Kids étant des versions allégées d'
Apache OpenOffice, vous serez parfois obligé de
réactiver des fonctionnalités qui ont été masquées
par souci de simplification.

Pour effectuer ce travail, vous pouvez vous référer
au chapitre traitant de la personnalisation des
barres de menu et des barres d'outils, dans le
manuel d'introduction Découvrir OpenOffice.

AOO, 0004Kids et OOoLight

Apache OpenOffice (AOO) est une suite
bureautique intégrée libre et gratuite (licence
Alv2.0) développée par ['Apache Software
Foundation (A.S.F.). Vous pouvez lutiliser
Iégalement sans frais de licence, aussi bien en
entreprise qu'a votre domicile, et méme participer
a son développement puisque son code source
est ouvert.

AOO intégre les applications suivantes : Writer
(traitement de texte), Calc (tableur), Impress
(PréAO), Base (base de données), Math (édition
de formules mathématiques), et Draw (dessin
vectoriel et PAO).

OOoLight est une version allégée, dérivée du
code d'OpenOffice. Sous licence libre LGPL 3.0,
elle est développée par l'association Educoo.org
et cible plus spécialement les adultes et les
seniors utilisant la bureautique de fagon moins
intensive.

Elle se caractérise par une interface simplifiée,
adaptable au niveau de compétence de
['utilisateur, est totalement indépendante de Java
et ne possede pas de module de base de
données.

00o04Kids est une version dérivée et simplifiée
de OpenOffice, sous licence libre LGPL 3.0,
développée par l'association Educoo.org avec la
participation d'acteurs du monde de I'éducation.

Son ergonomie et ses fonctionnalités ont été
adaptées a un public jeune (7-12 ans). Elle se
caractérise par une interface dessinée pour les
juniors, l'intégration de polices cursives, une totale
indépendance vis a vis de Java et l'absence du
module de base de données.

Crédits
Ce document a été réalisé a I'aide du traitement

de texte Writer des suites OOolight et Apache
OpenOffice™.
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1.Le module Impress

Captures d'écran

Les captures d'écran ont été réalisées et
retouchées a l'aide des logiciels Greenshot et
[rfanview.

Logos

Les logos OOoLight et OOo04kids ainsi que le logo
situé sur la page de couverture sont des
réalisations de Ben BOIS.

Conventions d'écriture

Les commandes

Les commandes et raccourcis clavier sont tous
écrits en gras.

- La commande Fichier > Imprimer ...> Options
- Avancé signifie qu'il faut commencer par
cliguer sur le menu Fichier, puis sur la
commande Imprimer ..., puis sur le bouton
Options .... dans la boite de dialogue
d’'impression, puis enfin sur l'onglet Avancé
dans la nouvelle boite de dialogue qui s'ouvre.

— Le raccourci Ctrl+N signifie qu’il faut d'abord
appuyer sur la touche Ctrl et la maintenir
enfoncée, puis appuyer sur la touche N du
clavier pour créer un nouveau document vide.

Les rubriques et les options

A quelques exceptions pres, les noms des boites
de dialogue ainsi que les rubriques et options
qu'elles renferment sont écrits en italique. Par
contre, les commandes et intitulés des boutons
commande sont écrits en gras.

Les remarques et commentaires

Remarques et commentaires additionnels sont
présentés dans une ligne de tableau, comme ici.

Licence d'utilisation

Titre : Découvrir Impress, le module de PréAO de
la suite bureautique OpenOffice.

Version : 26.04.13
Copyright 2012 - 2013 - Guy WATERVAL

Licensed under the Apache License, Version 2.0
(the "License"); you may not use this file except in
compliance with the License.

You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in
writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND,
either express or implied.

See the License for the specific language
governing permissions and limitations under the
License.

1.2. Démarrer Impress
Il existe plusieurs fagons de démarrer Impress :

1. En cliguant sur licone Impress depuis le
Centre de démarrage.

2. En langcant directement la commande de
démarrage d'Impress depuis le bouton
Démarrer du bureau de Windows.

3. Depuis I'Explorateur de fichiers, en double
cliquant sur un fichier au format Impress (.odt).

4. En utilisant le bouton de démarrage rapide
situé dans la traybar (AOO uniguement) ;

5. Depuis un raccourci clavier placé sur le bureau
de Windows.

6. Si un autre module de la suite est déja lancé,
on peut démarrer Impress en choisissant
I'entrée Impress dans le bouton Nouveau de
la barre d'outils Standard ou utiliser la
commande Fichier > Nouveau > Impress
depuis la barre des menus.

* Vous pouvez ajouter un raccourci direct pour
Impress dans le menu Démarrer en cliquant, avec
le bouton droit de votre souris, sur le lien
conduisant au module Impress, puis en
choisissant la commande contextuelle Ajouter
au menu Démarrer.

* Vous pouvez aussi ajouter, sur votre bureau
Windows, un raccourci de démarrage pour
Impress en faisant glisser, depuis le menu
Démarrer, le lien de démarrage directement sur le
bureau en maintenant la touche Ctrl enfoncée.

Toutes les méthodes de démarrage décrites ci-
dessus (a l'exception de la 3) aboutissent a
l'ouverture d'un nouveau document vide, basé sur
le modéle par défaut du programme.

Par contre, si Impress a été configuré pour
démarrer directement avec ['Assistant de
présentation, c'est alors la premiére étape de
celui-ci qui apparait et pas un document vide.
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1.Le module Impress

Pour configurer Impress de maniere a ce qu'il
démarre systématiquement avec l'assistant, cochez
I'option Démarrer avec ['assistant dans la boite de
configuration ouverte par la commande Outils >
Options...> Openoffice Impress > Général.

Nouveau document
Démarrer avec [gssistant

1.3. Interface d'Impress

La fenétre d'Impress se compose des éléments
suivants.

La partie supérieure de I'écran est occupée, de
haut en bas, par la barre de titre (1), suivie de la
barre des menus (2) puis de la barre d'outils
Standard (3) et des autres barres dont l'affichage
peut étre contrdlé par la commande Affichage >
Barres d'outils, comme par exemple, la barre
Ligne et remplissage (4).

La partie de I'écran occupée par la barre des menus
et les différentes barres d'outils est parfois aussi
appelée Zone des commandes.

GfF-aEd  Ea o= a LB-e s +A- @it -E-0 WY 3
= ‘-.wx. oo (8 [ | # foser W[Eoes o @ 4

Diapos X | [Mormal ptan [Nctes | Prospects | Trsse ds dapostives Thches  §  afcher v x
A b Fagns marosses

i |
[ = Mises en page

Cliquez pour ajouter un titre (—
ot

5 — ¢

6 1 =]
Cliquez pour ajouter un texte =

L J | |
==l I_I

& Ebauche de Rableau

I

Is S |5 Trarstion o depe.

B/ —@OT -L-B-@-»-W-P-*k-KAJs AB% 0R-%-8 4 9
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Sous cette zone, I'écran se partage en trois volets
de largeur adaptable adaptable a l'aide de la
souris :

- Volet Diapos (5) a gauche.

— Espace de travail (6) montrant, selon le mode
d'affichage choisi dans la barre des modes
d'affichage (7), la diapositive courante (en mode
d'affichage Normal), ou le plan de Ila
présentation (en mode d'affichage Plan), etc.

— Volet Taches (8) a droite remplacé par la Barre
latérale dans AOO 4.0.

Au bas de l'écran on trouve encore la barre
Dessin (9) puis la barre d'état (10) intégrant sur sa
droite 'outil Zoom.

Les volets extérieurs (Diapos et Taches) et la Barre
latérale (AOO 4.0) disposent tous d'un bouton
permettant de les masquer/afficher d'un clic de
souris.

Barre de titre

Elle renferme, en plus du nom du programme et
celui de la présentation active, les boutons
classiques de controle de la fenétre du
programme : Réduction, Agrandissement ou
Restauration et Fermeture.

Zone des commandes

Située en haut de I'écran, juste sous la barre de
titre, on y trouve essentiellement la barre des
menus et les barres d'outils disponibles par
défaut au lancement du programme. On peut
décider d'y ajouter/retirer d'autres barres par la
commande Affichage > Barres d'outils en les
cochant ou en les décochant dans la liste.

Par défaut, la barre d'outils Dessin occupe une
position particuliere : elle se place automatiquement
au bas de I'écran, juste au-dessus de la barre d'état,
mais vous pouvez treés bien l'ancrer ailleurs ou la
déposer sous forme de fenétre flottante dans
I'espace de travail.

Barre des menus

Elle renferme l'ensemble des commandes du
programme regroupées en catégories ou menus.
Cette barre est contextuelle, les commandes non
disponibles dans un contexte de travail donné
apparaissent grisées.

Barre Standard

Elle renferme, sous forme de boutons, les
commandes générales les plus utilisées
création, ouverture, fermeture et enregistrement
de fichier, insertion de tableaux, de diagrammes
ou d'hyperliens etc.

La barre est contextuelle, ce qui signifie que ses
commandes non applicables sont grisées.

Sur sa droite, comme c'est le cas dans toutes les
barres d'outils, un bouton rectangulaire suivi d'une

pointe de fleche orientée vers le bas = déroule
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1.Le module Impress

un menu comprenant les deux commandes
fondamentales suivantes :

— Boutons visibles : affiche la liste de tous les
boutons présents en standard dans la barre. Un
simple clic permet de les afficher ou de les
masquer dans celle-ci.

— Personnaliser la barre d'outils ... : ouvre une
boite de configuration pour ajouter d'autres
boutons non présents dans la liste par défaut ou
en supprimer.

Barre Présentation
Présentation ~ X

=R S TR

1 2 3 4
Elle renferme les boutons suivants :

1. Diapo : insére, a la suite de la diapositive
active, une diapositive de mise en page
similaire, ou choisie dans la palette qui
apparait lorsqu'on clique de maniére prolongée
sur le bouton ou sur la pointe de fleche située
a sa droite.

2. Mise en page de diapo : affiche la palette des
mises en pages possibles et permet de
changer la mise en page de la diapositive
active.

3. Conception de diapo : ouvre la boite Style de
diapo permettant de changer de modéle
d'arriére-plan.

4. Diaporama (F5) permet de démarrer la
projection du diaporama depuis la diapositive
courante.

Barre Ligne et remplissage

On y trouve, sous forme de boutons et de listes
déroulantes, les commandes de mises en forme
disponibles pour les objets graphiques intégrés
aux diapositives.

Barre Dessin

Elle renferme tous les outils nécessaires pour
tracer des formes de base, les modifier, les
aligner, etc. Cette barre se dispose par défaut en
bas de I'écran, juste au-dessus de la barre d'état,
mais rien ne vous empéche de l'ancrer ailleurs ou
de l'utiliser sous forme flottante.

Volet Diapos

L'affichage de ce volet est contrélé par la
commande Affichage > Volet Diapo. On peut
ajuster sa largeur a l'aide de la souris, en
déplacant simplement la barre verticale qui le
sépare de la zone d'affichage centrale.

Il s'agit d'un volet de navigation qui présente,
dans les modes Normal, Plan et Notes, les diapos
de la présentation sous forme de miniatures, et
permet de les afficher dans l'espace de travall
d'un simple clic. Grace a une barre de défilement,
il est possible d' accéder aux miniatures non
visibles a I'écran.

Depuis ce volet on peut facilement naviguer entre
les diapositives et méme les déplacer a la souris
comme on le ferait (avec plus de confort toutefois)
en mode d'affichage Trieuse de diapositives.

Ce volet peut étre déplacé dans l'espace de travail
sous forme de fenétre flottante.

Lorsqu'il est ancré, un bouton rectangulaire intitulé
Masquer, apparaissant au milieu de la ligne
verticale qui le sépare de la zone d'affichage
centrale, permet de le masquer ou de l'afficher d'un
simple clic.

Lorsqu'on pointe sur une miniature, trois icénes
apparaissent sur un fond noir au bas de la
miniature. Elles permettent de démarrer le
diaporama depuis la diapo courante, de la
masquer ou de la dupliquer.

2 Apropos de o= 0o ment

= e il e Lk P o sl wue
o0 o | e, sk | sl penaciud T polr b T
EasnaL i -

14 Llsamrs mim
BF orar ar G Waraesd (Ba @ Ploras, S04,
R S e | s’ aghe poe d'una
da curranearian oficlalla

. ’jMasquer diapmﬁ

Les miniatures possédent toutes un menu
contextuel avec des commandes permettant
d'insérer une nouvelle diapositive, ou encore de
renommer, supprimer, masquer, copier la
diapositive sélectionnée. On peut aussi changer
son masgue ou sa mise en page, et méme lui
définir un effet de transition.

En bas et a gauche de chaque miniature affichée, un
symbole indique si un effet de transition est associé
a la diapositive.
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1.Le module Impress

Volet Taches

ATTENTION !
Ce volet n'existe plus que dans OOolLight, O004Kids
et dans les versions AOO antérieures a la 4.0.
Dans AOO 4.0, ses fonctionnalités ont été intégrées
dans une nouvelle barre: la Barre latérale
(Sidebar).

On peut afficher ou fermer le volet Taches par la
commande Affichage > Volet Taches. Il peut étre
déplacé dans l'espace de travail comme fenétre
flottante ou ancré & un bord de I'écran. Dans ce
dernier cas, un bouton Masquer situé sur la barre
verticale qui le sépare de la zone d'affichage
centrale permet de le masquer (sans le refermer)

ou de lafficher a nouveau. Sa largeur est
ajustable a I'aide de la souris.

Taches Afficher -~ X

< Pages maitresses
=l utilisées dans cette présentation

e s ]
(=1

=l Récemment utilisées

= Disponibles pour 'utilisation

g - s
e —
—_—

TR
IR N AN

i Mises en page
b Ebauche de tableau
> Animation personnalisée

i Transition

Ce volet regroupe, sous 5 onglets, les principales
fonctionnalités utilisées lors du travail sur une

présentation : Pages maitresses, Mises en page,
Ebauche de tableau, Animation personnalisée,
Transition.

Les onglets de ce volet peuvent étre rendus
disponibles ou masqués en les cochant ou en les
décochant dans la liste déroulante du bouton
Afficher, situé dans la barre de titre du volet.

Taches Affichar - X
= Pages m i Pages matresses
[ - Utilisdes  |Mises en page
= v Ebauche de tabizau
v | Animation personnalisés
| #* | Trarsition

- Récem. Détacher le volet Taches

Barre latérale (Sidebar)

Dans la version AOO 4.0, le volet Téches est
remplacé par une nouvelle barre d'outils, la Barre
latérale, bien plus riche en fonctionnalités, dont
l'affichage est contrdlé par la commande
Affichage > Barre latérale.

La barre latérale peut étre affichée dans tous les
modes d'affichage, avec tous ses volets. Lorsqu'un
mode de travail ne permet pas de réaliser les taches
prévues dans un volet, le contenu de celui-ci
apparait grisé car non accessible.

Cette nouvelle barre intégre les volets Pages
maitresses, Mises en page, Animation
personnalisée et Transition de l'ancien Volet
Taches. Elle contient aussi un nouveau volet
Propriétés, ainsi que les volets Styles et
formatage, Navigateur et Gallery, méme si ces
derniers restent encore accessibles sous forme
de fenétres ancrables indépendantes, comme
dans les versions précédentes.

Le volet Propriétés, entierement contextuel,
fournit un acceés direct aux principales
commandes de mise en forme applicables aux
contenus rencontrés dans les diapositives : textes
ou objets graphiques. Il permet souvent de se
passer des barres d'outils et menus contextuels et
apporte un réel confort lors de la mise en forme
du contenu des diapositives.

Comme vous pouvez le constater, les
commandes disponibles dans le volet Propriétés
se répartissent en différents Panneaux (groupes).
Ceux-ci peuvent étre dépliés ou réduits
individuellement et ils possédent tous sur leur
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1.Le module Impress

droite un lanceur de boite de dialogue donnant
acces a la boite de dialogue qui renferme
l'intégralité des commandes disponibles pour le
panneau.

Ci-dessous une copie d'écran du volet Propriétés,
tel qu'il apparait lorqu'une forme se trouve
sélectionnée dans la diapositive courante.

Properties X =
+ Text
t| Paragraph
= Area |
Eill:
Color - 4] -
-+
Transparency:
MNone x| 0% -
=l Line
Wiclth: Color;
Style: Transparency:
| 0%
Arrow:
- none - * | - nocne- -
Corner style Cap style
Rounded - | |Flat -

+ Position and Size

Tous les volets qui peuvent étre affichés sont
accessibles depuis la barre d'onglets située sur la
droite de la barre latérale.

Vous trouverez des informations supplémentaires
sur la manipulation de la barre latérale dans le
module intitulé Découvrir OpenOffice.

Espace de travail

C'est la zone centrale de I'écran dans laquelle
s'affichent les diapositives ou le plan de la
présentation lorsqu'on travaille dessus. Il est
surmonté d'une barre comprenant 5 onglets,
appelés Boutons de mode : Normal, Plan, Notes,
Prospectus et Trieuse de diapositives.

UNDrmal |F‘Iar'| [Motes || Prospectus | Trieuse de diapasitives |

Ce qui apparait dans cette zone dépend du mode
d'affichage sélectionné dans le menu Affichage ou
au niveau de la barre des Boutons de mode
représentée ci-dessous.

Normal Plan |Notes | Prospectus | Trieuse de diapositives

Notez que cette barre n'intégre pas de bouton
permettant de démarrer la projection. Ceci doit se
faire par la commande Affichage > Diaporama, le
raccourci F5 ou le bouton Diaporama dans les
barres d'outils Standard ou Présentation.

Ces modes d'affichage ont pour but de mettre a
disposition I'environnement et la palette de
commandes les plus adaptés a la réalisation de
certaines taches.

Barre d'état

On peut afficher ou masquer la barre d'état par la
commande bascule Affichage > Barre d'état.

On y trouve une série de champs avec des
informations sur I'état du travail en cours. De
gauche a droite :

Edition texte : Paragraphe 1, Ligne 1, Colonne 1
1

| #234.09/1342¢% 000%x000 |*| | Diapo1/14 | Iyt-cool
2 3 4 35 6 7

e—e—+—@|5m%
8 9

Information sur I'action en cours d'exécution.

Position du point d'insertion.

Dimensions de I'objet sélectionné.

Etat d'enregistrement de la présentation.

Signature numérique : une icéne indique si le

document est signé numériquement. Aprés

enregistrement de la présentation, un double

clic sur ce champ ouvre la boite Signature

numérique.

6. Numéro de la diapo courante/nombre total de
diapos dans la présentation active.

7. Nom du modele (Page maitresse) associé a la

diapo affichée dans la zone de travail. Un clic

droit sur cette zone permet d'appliquer

rapidement une page maitresse différente a la

diapo active (si plusieurs modéles sont utilisés

dans la présentation).

abrwnpE
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1.Le module Impress

8. Outil permettant de choisir la valeur de zoom a
appliquer a l'espace de travail en faisant
glisser un curseur.

9. Champ affichant le facteur d'agrandissement
actif de la zone de travail. On peut en choisir
un autre dans un menu contextuel. Un double
clic sur ce champ ouvre la boite de dialogue
Zoom & Disposition des pages.

Fenétres ancrables

Comme les autres modules de la suite, on peut
afficher a tout moment dans Impress les fenétres
spéciales suivantes: Navigateur, Styliste et
Gallery.

Dans AOO, depuis la version 4.0, ces fenétres sont
également intégrées comme volets dans la barre
latérale.

Le Navigateur

Pour l'ouvrir, cliquez sur le bouton Navigateur
dans la barre d'outils Standard ou utilisez la
commande Affichage > Navigateur ou le
raccourci Ctrl+Maj+F5.

Les diapos de la présentation sélectionnée dans
la liste déroulante Documents s'affichent alors en
réduction dans la fenétre du Navigateur et vous
pouvez faire glisser :

— une diapo de la liste dans le volet Diapos de la
présentation active affichée en mode Normal, a
I'endroit de votre choix pour l'insérer;

— un objet de l'une des diapositives affichées dans
le navigateur dans la diapositive active de votre
présentation affichée en mode Normal

Comme toujours avec le Navigateur, les insertions
peuvent étre réalisées sous forme de copies ou
de liens.

* La barre d'outils du Navigateur intégre des
boutons de navigation permettant de se déplacer
dans les diapositives de la présentation active.

* La liste Documents du Navigateur affiche
uniquement les présentations qui sont chargées.

* Lorsque le Navigateur affiche Ila liste des
diapositives de la présentation affichée a I'écran,
un double clic sur I'une des diapos de la liste la
sélectionne et I'affiche en mode Normal.

La fenétre de gestion des styles (Styliste)

Elle affiche la liste des types de styles actifs dans
le mode d'affichage dans lequel on se trouve et
permet de les modifier.

La fenétre de la Gallery

Permet d'insérer ses contenus multimédias dans
les diapositives en mode Normal.

1.4. Modes d'affichage

Le travail sur une présentation implique de
pouvoir disposer a tout moment d'un
environnement de travail optimal pour les taches
a réaliser. C'est pour cela que Impress offre la
possibilité de basculer entre plusieurs modes
d'affichage (vues) de l'espace de travail, certains
plus adaptés que d'autres pour réaliser certaines
taches.

Mode Normal

C’est le mode d'affichage par défaut a I'ouverture
du programme, et celui qu'on utilise le plus
souvent. Il permet a la fois la création de
nouvelles diapositives et la conception de leur
contenu par insertion de textes, images, etc.

Dans ce mode, la diapositive active s'affiche au
centre de I'écran. On peut modifier sa mise en
page et définir des effets d'animation pour ses
contenus.

Le volet Diapos

Ce volet affiche les diapositives sous forme de
vignettes et permet de passer facilement de l'une
a l'autre. Un simple clic sur I'une des vignettes fait
apparaitre la diapositive correspondante au
centre de linterface pour permettre de la
retoucher.

Le volet Taches

Situé a droite de I'écran, ce volet détachable se
compose de cing volets représentés par des
onglets :

Téches Afficher ~ X

¥ Pages maitresses

B Mises en page

» Ebauche de tableau

B Animation personnalisée
< Transition de diapo
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1.Le module Impress

- Pages maitresses : affiche en réduction la ou
les page(s) maitresse(s) servant de modéle(s)
aux diapositives de la présentation. Celle qui est
litce a la diapositive active se trouve
sélectionnée dans la catégorie Utilisées dans
cette présentation. Ces pages maitresses sont
le support de toutes les propriétés graphiques
transmises aux diapos qui leur sont liées. Les
styles responsables du formatage des différents
éléments intégrés aux pages maitresses, et que
vous pouvez modifier a tout moment selon vos
besoins, se trouvent dans la fenétre du Styliste
sous deux catégories : Styles de présentation et
Styles d'images.

— Mises en page : liste de gabarits permettant de
choisir une mise en page optimale pour les infos
a intégrer dans les diapositives. La mise en
page appliquée a la diapositive active se trouve
sélectionnée. Cette liste est fixe, l'utilisateur ne
peut pas y ajouter de mises en page
personnalisées. Par contre, on peut modifier la
mise en page appliquée a une diapositive.

— Ebauche de tableau : propose un choix de
styles de tableau utilisables pour insérer un
tableau dans la diapositive active affichée en
mode Normal. Pour chagque modele, vous
pouvez choisir les éléments appliquer en les
cochant dans une liste. Ce volet n'apparait plus
dans AOO 4.0.

— Animation personnalisée : permet de créer
des effets d'animation applicables aux contenus
des diapositives.

— Transition : permet de gérer les effets qui
accompagneront le passage d'une diapositive a
l'autre lors de la projection.

La barre latérale (AOO 4.0)

Dans AOO 4.0, c'est la barre latérale qui remplace
et inteégre les fonctionnalités du volet Taches.

Le nouveau volet Propriétés renferme les
différentes mises en page possibles pour la
diapositive active et lorsqu'un contenu se trouve
sélectionné dans une diapositive, c'est alors
'ensemble des commandes qu'on peut lui
appliquer qui sont alors proposées dans différents
panneaux.

Mode Plan

Le Mode Plan affiche, sous forme de plan, le texte
principal de toutes les diapositives de la
présentation, avec leur titre. Vous pouvez utiliser
ce mode pour créer de nouvelles diapos,
réorganiser leur ordre de succession, éditer leur
titre et le texte saisi dans leurs espaces réservés,
etc.

Vous ne pouvez pas insérer des images ou autres
objets dans ce mode.

Le texte présent dans les boites de texte et les
formes n'apparait pas en mode Plan.

Ce mode dispose d'une barre doutils Plan
intégrant des commandes qui permettent d'agir
sur les niveaux du plan.

Si la barre ne s'affiche pas, utilisez la commande
Affichage > Barres d'outils > Plan pour la faire
apparaitre.

Pan vx
IERERERE

En cliquant, avec le bouton droit de la souris, sur
du texte sélectionné, un menu contextuel
apparait, avec des commandes de mise en forme
de texte. Dans ce mode, le Syliste montre la liste
des styles de  présentation  appliqués
automatiquement aux différents niveaux du plan.

Une seconde barre d'outils apparait également
dans ce mode: la barre Formatage du texte,
pour réaliser des mises en forme directes de
texte.

Formatage du texte il
|Aria| BH32 E‘ 6 I S Mk

= =] Te= v LK AdEE A-
Si vous utilisez AOO 4.0, ces commandes vous

seront également mises a disposition dans le
volet Propriétés de la barre latérale.

Properties

=] Text

Albany «| 44 [+] € X
B|/7 U~ a -
A
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1.Le module Impress

Le mode Plan permet aussi de modifier l'ordre
des diapositives sans passer par le volet Diapos.
Il suffit pour cela d'effectuer un cliquer déposer,
vers un autre emplacement dans le plan, des
symboles précédant le titre des diapositives.

Mode Notes

I permet au présentateur d'annoter ses
diapositives sans que ses commentaires ne
soient visibles de l'assistance lors de la projection.

L'impression des pages en mode Notes permet de
distribuer aux auditeurs une version papier de la
présentation accompagnée des commentaires.

Dans ce mode, chaque diapositive s'affiche sous
forme de page A4, avec une vignette de la
diapositive dans la partie supérieure et un cadre
dédié a I'édition de texte dans la partie inférieure
(ce cadre peut étre redimensionné a l'aide de la
souris).

Pour ajouter du texte dans le cadre inférieur,
cliguez simplement dans la zone intitulée Cliquez
ici pour ajouter des notes, puis tapez votre texte
sans vous soucier de sa mise en forme, celle-ci
est prise en charge par l'application automatique
du style de présentation Notes. Si le formatage
obtenu par l'application de ce style automatique
ne vous convient pas, vous pouvez modifier le
style.

Les outils de la barre Formatage du texte vous
permettent de réaliser facilement des mises en
forme directes du texte de vos notes.

Si vous utilisez AOO 4.0, la plupart de ces
commandes vous seront également accessibles
depuis le volet Propriétés de la barre latérale.

Mode Prospectus

Ce mode permet de distribuer la présentation
sous forme de planches contacts dont on peut
choisir la mise en page dans l'onglet Mises en
page du volet Taches.

Selon la disposition choisie, les pages
contiendront plus ou moins de diapositives en
réduction (1, 2, 3, 4, 6 ou 9). Les diapositives
présentes sur une page dans ce mode sont
représentées par des cadres vides qu'il est
possible  de  sélectionner  déplacer et
redimensionner a la souris.

< Mises en page

Dans AOO 4.0, vous trouverez les mises en
pages possibles dans le volet Propriétés de la
barre latérale.

Mode Trieuse de diapositives

Les diapositives s'affichent sous forme de
miniatures, comme si elles étaient étalées sur une
table lumineuse, ce qui offre une vue d'ensemble
de la présentation. Un double clic sur une
diapositive la fait apparaitre en mode d'affichage
Normal.

Vous pouvez modifier le nombre de diapositives
affichées sur une ligne en indiquant le nombre
souhaité dans la liste déroulante de la barre
d'outils Mode Diapo.

E{}ode Diapo v X
| @ |4 Diapos El

Le mode Trieuse de diapositives est idéal pour
réaliser les travaux de finition, réorganiser l'ordre
des diapos, produire un diaporama chronométré
ou ajouter des effets de transition a des
diapositives sélectionnées.

Un sigle placé prés du coin inférieur gauche de
chaque diapositive signale si un effet de transition
lui est associé.

Rapport de marketing Notre évolution

Akl e o &

#  #Apercy du chiffre daff, .

@ Raisons de cetbe stua. ., *» alternatives possiles

Dans ce mode, on peut :
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1.Le module Impress

— Réorganiser l'ordre de succession des
diapositives en les déplagcant a l'aide de la
souris. Une barre verticale noire symbolise le
point d'insertion et facilite le repérage de la
position finale.

- Importer des diapositives a la souris.

— Masquer certaines diapositives (Présentations
personnalisées)

— Créer une diapositive de résumé
— Définir les effets de transition, c'est-a-dire la

maniere dont on passera d'une diapositive a
l'autre lors de la projection.

Les miniatures possedent un menu contextuel avec
des commandes permettant d'insérer une nouvelle
diapo, de supprimer ou de renommer la diapositive
sélectionnée, de changer sa mise en page, de lui
définir un effet de transition, de la masquer, de la
copier ou de coller juste avant elle une diapositive
en provenance du presse-papiers de Windows.

Pour sélectionner un groupe de diapositives,
procédez de l'une des maniéres suivantes :

— Pour sélectionner un groupe de diapositives
adjacentes, effectuer un cliquer glisser a l'aide
de la souris, en cliqguant d'abord juste a gauche
de la premiere diapositive a sélectionner. On
peut aussi cliquer sur la premiére diapositive du
groupe, puis appuyer sur la touche Shift avant
de cliquer sur la derniere a intégrer dans la
sélection.

— Pour sélectionner un groupe de diapositives
isolées, il suffit de cliquer sur chacune d'elles
avec la touche Ctrl enfoncée.

Mode Diaporama

C'est le mode de projection (F5) : les diapositives
s'affichent en plein écran et un simple clic de
souris permet de passer d'une diapositive a la
suivante. On peut également utiliser les fleches
de navigation horizontales du clavier pour passer
d'une diapositive a l'autre.

La projection peut étre interrompue a tout
moment, avec retour au mode Normal en
appuyant sur la touche Escape.

Le zoom

Pour améliorer le confort de lecture, on peut
zoomer sur l'espace de travail, dans tous ses

modes d'affichage, a I'exception du mode Trieuse
de diapositives.

Le facteur de zoom adopté n'affecte en rien la taille
réelle des diapositives ni celle de leurs contenus.

Les outils de Zoom sont disponibles dans la barre
d'état et le menu Affichage.

Champ Zoom dans la barre d'état

Ce champ affiche la valeur de zoom appliquée et
permet d'en choisir une autre dans un menu
contextuel.

Boite Zoom

Zoom & Disposition des pages

Facteur de zoom
Optimal
O mdapter les largeur et hautewr
O Adapter 3 la |argewr
O 100 %

(®) yariable

Un double clic sur le champ Zoom dans la barre
d'état ou la commande Affichage > Zoom ...
ouvrent une boite dans laquelle on peut définir
une valeur précise de zoom.

Outil Zoom

Cet outil, situé dans la barre d'état, juste avant le
champ Zoom, permet un réglage en continu de la
valeur de zoom en faisant glisser un curseur.

o—e—+—@|| 45% |

1.5. Configurer Impress

La commande Outils > Options ... - OpenOffice
Impress propose, dans 4 boites de dialogue
(Général, Afficher, Grille, Imprimer), toutes les
options de personnalisation spécifiques au
module Impress. Pour y accéder, il suffit de
cliquer sur le signe + en regard de la rubrique
OpenOffice Impress dans la partie gauche de la
boite.

Nous ne nous attarderons pas trop sur les options
de configuration proposées dans ces boites, car
les options prévues par défaut conviennent dans
la majorité des cas.
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1.Le module Impress

Options générales

Objets de texte

Le comportement des objets de texte a la
sélection est régi par deux options :

— Permettre ['édition rapide : si |'option est active,
on bascule automatiquement en mode Edition
de texte en cliquant sur le texte contenu dans
un objet de texte.

— Seule la zone de texte peut étre sélectionnée :
activez cette option pour qu'un cadre de texte
ne puisse étre sélectionné qu'en cliquant sur le
texte qu'il contient (cliquer sur le cadre ne suffit
pas). Dans la zone restante (non remplie), il est
alors possible de sélectionner un objet sous-
jacent au travers du cadre de texte.

Ohijets de texte
Permettre 'edition rapide

Seule la zone de texte peut &tre selectic

Molveau docurnent
Demarter avec |'assistant

Pararnétres
Utiliser le cache d'atrigre-plan

[ Corie lors du déplacement
Ohjets toujours déplacables

Lancer la présentation

Toujours avec la page active

Unité de mesure

Compatibilité
[ utiliser les mesures de mptimante pour ke formatage du document
Ajouter un espacement entre paragraphes et tableausx (document actif)

Nouveau document

Démarrer avec l'assistant : si I'option est active, la
premiére boite de l'assistant de création apparait
lors de toute demande de création d'une nouvelle
présentation. Dans le cas contraire, c'est une
nouvelle présentation vide, basée sur le modéle
par défaut qui s'affiche.

Parameétres

— Utiliser le cache d'arriere-plan : indique si le
cache doit étre utilisé pour afficher les objets sur
la page maitresse, afin d'accélérer l'affichage.
Décochez I'option pour afficher les modifications
du contenu de la page maitresse.

— Copie lors du déplacement : indique si une
copie est automatiquement créée lorsqu'on
déplace un objet en maintenant la touche Ctrl
enfoncée. La méme régle s'applique en cas de
rotation ou de redimensionnement d'un objet.

L'objet d'origine conserve sa position et sa taille
initiales.

— Objets toujours déplacables : indique si l'outil
Rotation permet de déplacer un objet lorsqu'il
est activé. Si l'option n'est pas cochée, l'outil
Rotation permet uniquement de faire pivoter un
objet, mais pas de le déplacer.

— Unité de mesure : permet de choisir I'unité de
mesure a utiliser.

— Espace entre les tabulations
entre les tabulations.

définit I'écart

Lancer la présentation

Offre la possibilité de toujours lancer la
présentation depuis la page active ou pas.

Compatibilité

— Utiliser les mesures de limprimante pour le
formatage du document indique que les
mesures de limprimante sont appliquées a
l'impression, ainsi qu'a l'affichage a I'écran. Si
cette case n'est pas cochée, une mise en page
indépendante de l'imprimante est utilisée pour
I'affichage a I'écran et I'impression.

— Ajouter un espacement entres paragraphes et
tableaux : ajoute ou non un espacement entre
les tableaux et paragraphes dans le document
actif.

Options d'affichage

— Régles visibles : indique si les régles doivent
étre affichées en haut et a gauche de la zone de
travail.

— Repeéres lors du déplacement : indique si des
repéres s'affichent lors du déplacement d'un
objet, pour faciliter son positionnement.

— Tous les points de contréle de I'éditeur Bézier :
affiche les points de contréle de tous les points
d'appui lorsqu'on sélectionne une courbe de
Bézier. Si l'option est désactivée, seuls les
points de contréle du point d'appui sélectionné
sont visibles.

— Contour de chaque objet : lorsqu'on déplace un
objet, le programme affiche son contour sous
forme de ligne discontinue pour faciliter la
reconnaissance d'éventuels conflits entre les
différents objets sur la position cible. Si la case
n'est pas cochée, le programme n'affiche qu'une
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1.Le module Impress

bordure rectangulaire incluant tous les objets
sélectionnés.

La grille
Grile
Aligner sur la grile
[ Grille visible
Résalution Finesse
Horizortal Horizortal pioint ()
Wertical Wertical pointis)

[ synchroniser les axes

Capturer Enclencher
[ £ux lignes de capture [ Lors de la création et du déplacement

Arétes plus [ongues

[ Pendant la ratatio {15.00 degrés
Reduction de point  |15.00 degrés |

AL MArges
[ au cadre de l'ohjet
[ sux paints de l'okjet

Zone de capture

Grille

— Capturer a la la grille : active la "magnétisation”
de la grille. Dans ce cas, les objets ne peuvent
étre déplacés entre les points de la grille. Pour
modifier le statut de la grille pour une action
ponctuelle, faire simplement glisser l'objet en
maintenant la touche Ctrl enfoncée.

— Grille visible : spécifie si la grille doit étre
affichée ou pas.

Résolution

— Horizontale : permet de définir I'écart des points
au niveau de l'axe X dans l'unité de mesure
active.

— Verticale : permet de définir I'écart des points au
niveau de l'axe Y dans l'unité de mesure active.

Subdivision

— Horizontal : indique le nombre d'intervalles entre
les points de la grille sur I'axe X.

— Vertical : indique le nombre d'intervalles entre
les points de la grille sur I'axe Y.

— Synchroniser les axes indique si les
paramétres courants de la grille doivent étre
modifiés symétriguement. Les parametres de
résolution et de subdivision des axes X et Y
restent inchangés.

Capturer

— Aux lignes de capture : des qu'on relache le
bouton de la souris, le bord d'un objet déplacé
est capturé a la ligne de capture la plus proche.

— Aux marges aligne le contour de I'objet
graphique sur la marge la plus proche lorsque le
curseur ou une ligne de contour de Il'objet se
trouve dans la zone de capture.

— Au cadre de l'objet : permet d'aligner le contour
de l'objet graphique sur le cadre de I'objet
graphique le plus proche lorsque le curseur ou
une ligne de contour de l'objet graphique se
trouve dans la zone de capture.

— Aux points de ['objet permet d'aligner le
contour de l'objet graphique sur les points de
I'objet graphique le plus proche, & condition que
le curseur ou une ligne de contour de l'objet
graphigue se trouve dans la zone de capture.

— Plage de capture : définit la distance de capture
entre le pointeur de la souris et le contour de
I'objet. Impress effectue la capture a un point de
capture uniqguement si le pointeur de la souris
se trouve a une distance inférieure a celle
sélectionnée dans le compteur Plage de
capture.

Position de capture

— Lors de la création et du déplacement : lors de
la création ou du déplacement, les objets
graphiques restent horizontaux, verticaux ou en
diagonale (45°). Ainsi, lors de la création, un
rectangle devient un carré et une ellipse devient
un cercle. Pour désactiver provisoirement ce
paramétre lors du traitement, appuyez sur la
touche Shift.

— Etendre les bords : indique qu'un carré est créé
sur la base du plus long c6té d'un rectangle
lorsqu'on appuie sur la touche Shift avant de
relacher le bouton de la souris. Ceci s'applique
également pour une ellipse (un cercle est créé
sur la base du plus long diamétre de I'ellipse). Si
la case Etendre les bords n'est pas cochée, le
carré ou cercle est créé sur la base du plus
court c6té ou diametre.

— Lors de la rotation : indique que les objets
graphigues peuvent pivoter uniquement dans
les limites de l'angle de rotation défini dans le
compteur. Pour pivoter d'une valeur supérieure
a cet angle, maintenez la touche Ctrl enfoncée
pendant la rotation et ne relachez la touche que
lorsque la valeur souhaitée de l'angle de
rotation est atteinte.
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1.Le module Impress

— Réduction de point : définit I'angle de réduction
des points.

Options d'impression

La commande : Outils > Options > OpenOffice
Impress > Imprimer permet de définir les
contenus a imprimer, la qualité d'impression
souhaitée, ainsi que des options de page lors
d'une impression sous Impress uniguement. Les
choix effectués ici sont enregistrés avec le
document.

Qualité

— Par défaut : imprime dans la couleur d'origine
sur une imprimante couleurs ou en niveaux de
gris sur une imprimante monochrome, y compris
toutes les couleurs/images d'arriere-plan.

— Niveaux de gris : imprime en noir, blanc et en
niveaux de gris sur les imprimantes couleurs et
monochromes, mais sans imprimer les couleurs
de fond ou les images d'arriére-plan.

— Noir et blanc : imprime en noir, blanc et en
niveaux de gris, mais sans imprimer les
couleurs de fond ou les images d'arriére-plan.

Imprimer
Définit des éléments supplémentaires a imprimer
dans la marge de la page (nom de la page, date,
heure, etc.).

Options de la page

— Standard : imprime les diapos en taille réelle.

— Adapter au format de la page : réduit les pages
de la composition pour pouvoir les faire tenir sur
le format de papier utilisé par l'imprimante.

— Pages en mosaique : imprime plusieurs diapos
de la composition sur une page, si leurs
dimensions le permettent.

— Brochure : imprime la présentation en recto
verso sous forme de livret (brochure) au format
A6 avec deux diapos sur chaque face.
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Une présentation est un document composé de
pages distinctes qui s'enchainent dans un ordre
donné et permettent d'exposer un sujet (projet,
bilan, cours, etc.) a I'aide d'un projecteur.

Les pages peuvent renfermer différents types
d'objets : graphiques, tableaux, images, textes,
arrieres-plans, sons, animations, vidéos. Elles
peuvent se présenter sous forme de diapositives
ou de transparents.

Des effets d'animation peuvent étre attachés aux
objets et des effets de transition peuvent
accompagner le passage d'une diapositive a
l'autre en projection, pour obtenir un diaporama
plus vivant.

Selon le support de sortie choisi, on peut classer
les présentations en plusieurs catégories :

— Présentations sur écran d'ordinateur ou desti-
nées une projection sur grand écran a l'aide
d'un vidéoprojecteur. La projection peut
s‘accompagner d'effets dynamiques :

« de transition pour permettre un passage plus
harmonieux d'une diapositive a l'autre ;

» danimation d'objets présents sur les
diapositives pour rendre la projection plus
vivante.

- Présentations sous forme de transparents
(en noir et blanc ou en couleurs) projetés sur
écran a l'aide d'un rétroprojecteur, sans effets
dynamiques possibles.

— Présentations imprimées sur papier pour étre
ensuite distribuées a l'assistance.

Lors de la création d'une nouvelle présentation, il
faut toujours tenir compte, lors du choix du modeéle
de base, du type de présentation a créer, car il
influence fortement le choix du modele a utiliser.

2.1. Quelques conseils utiles

Voici quelques recommandations générales pour
obtenir une bonne présentation.

Rythme d'une présentation

On conseille généralement une vitesse de
projection de 1 a 3 minutes par diapositive, ce qui
revient a créer 10 a 30 diapositives pour un
exposé de 30 minutes.

Structurer clairement les idées

Une bonne présentation doit étre structurée
comme suit :

1. Introduction
2. Développement
3. Conclusion

Le suivi du plan exposé au début de la
présentation, sera facilité en insérant, par
exemple en en-téte des diapositives, un rappel du
titre de la partie en cours et en utilisant une
numérotation des diapositives qui integre le
nombre total de diapositives a projeter.
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2.Créer une présentation

Police et taille des caracteres

De préférence, sans sérif (empattements) : les
polices Arial, Verdana et Tahoma donnent
généralement de bons résultats.

La taille des caractéres dépend de la distance
entre le spectateur et I'écran. En régle générale,
on conseille comme tailles minimales :

— 20 pts pour une distance a I'écran d'environ
15m

— 30 pts pour une distance a I'écran de 20 m ou
plus

Bien choisir les couleurs

Tenir compte du public cible, du sujet traité, des
caractéristigues de la salle ou le diaporama est
projeté.

On utilisera de préférence :

— des couleurs sombres ou vives pour les textes ;

— une couleur de fond qui contraste suffisamment
bien avec celle utilisée pour les textes.

En principe, ces questions de couleurs ne devraient
pas causer de soucis si on construit la présentation
sur un modéle.

Si les diapositives doivent étre imprimées, il faut
éviter un fond sombre, afin d'économiser les
cartouches d'encre.

Eviter de surcharger

Chaque diapositive doit posséder un point de
départ qui accroche le public et véhiculer une
seule idée développée sous forme d'une liste
d'arguments.

Dans la majorité des cas, le texte doit étre aligné
a gauche, il ne doit jamais étre justifié.

Il faut éviter d'utiliser des caractéres gras, car ils
nuisent & la lisibilité.

Le texte principal de chaque dia doit étre succinct,
ne pas dépasser 5 a 7 lignes par diapositive.

Lorsque l'argumentation se base sur un schéma
complexe, il est conseillé de le découvrir
progressivement, par étapes successives, en
dévoilant ses différentes parties les unes aprés les
autres, pour une meilleure lisibilité.

Une création par étapes

1. On commence par créer une présentation de
base, qui peut étre héritée d'un modele,

correspondre a un plan de document exporté
depuis Writer, ou carrément une présentation
existante qu'on modifie. Cette premiére phase
est réalisée manuellement ou & l'aide d'un
assistant permettant de déja faire certains
choix, comme un arriére plan commun a toutes
les pages, un type de support de sortie
(diapositives, transparents, ou pages
d'impression).

2. On poursuit en modifiant ou complétant la
structure et les textes en mode Plan. Puis on
bascule en mode d'affichage Normal pour
insérer des contenus aux diapositives
(illustrations et ou textes supplémentaires dans
des espaces réservés ad hoc, comme les
boites de texte ou les formes) et
éventuellement leur associer des effets
d'animation.

3. Dans une troisieme étape, on finalise la
présentation en vue de sa projection. On peut
ici retoucher l'ordre de succession des diapos
en les affichant en mode Trieuse de
diapositives, ajouter une diapositive
fournissant le plan de l'exposé (diapositive
sommaire) puis définir ou redéfinir les effets de
transition et d'animation souhaités. Cette étape
se termine par un paramétrage de la
projection.

2.2. Création manuelle

Une présentation est toujours basée sur un
modeéle dont elle hérite le design général, c'est-a-
dire l'arriére plan et tous les styles de listes et de
caractéres, avec parfois quelques diapositives de
contenus.

Les attributs transmis par le modéle aux
diapositives sont enregistrés dans ce qu'on
appelle un masque de diapositive appelé
également page maitresse. Ce masque peut étre
édité dans un mode de travail spécial, le mode
Masque, si on souhaite le modifier.

Lorsqu'une présentation est segmentée en plusieurs
parties, chacune d'elles peut étre liée a sa propre
page maitresse, pour mieux marquer les différentes
parties.
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2.Créer une présentation

Les modeles

Les modéles Impress se répartissent en deux
catégories : modéles d'arriere-plan et modéles de
présentation.

lls sont enregistrés avec l'extension .OTP et sont
réutilisables, car ils ne sont pas affectés par les
modifications entreprises dans une présentation
qui les utilise.

Modéles d'arriere-plan

Les modéles d'arriere-plan (appelés modéles de
conception dans PowerPoint) se limitent & fournir
un design général a la présentation. Leurs
propriétés sont enregistrées dans une Page
maitresse  (masque) qui  transmet  ses
caractéristiques aux diapositives auxquelles on la
lie. Ces pages maitresses fournissent les
masques de diapositives, Notes et Prospectus
responsables de l'apparence de ces éléments.

L'un des éléments fondamentaux d'un modele
d'arriére-plan est son jeu de couleurs, composé des
couleurs utilisées pour l'arriére-plan, les lignes et le
texte, les ombres, les remplissages, les liens
hypertexte, etc. il s'agit la d'une composante
fondamentale d'une page maitresse, puisqu'elle
conditionne la lisibilité des diapositives.

Modéles de présentation

Les modéles de présentation (appelés aussi
modeéles de contenu dans PowerPoint) sont plus
élaborés. Ce sont de \véritables petites
présentations thématiques destinées a fournir des
idées réutilisables lors de la création d'une
présentation du méme genre.

Ces modeles peuvent contenir plusieurs pages
maitresses, ainsi que quelques diapositives de
contenus, avec des suggestions de texte, de titres
et méme des objets pré-insérés, qu'on peut
modifier pour arriver plus rapidement a une
présentation de base.

Lorsqu'on base la création d'une nouvelle
présentation sur un modele, on ouvre en fait une
copie du modeéle choisi (et non le modéle lui-méme)
et c'est sur cette copie qu'on travaille pour créer la
nouvelle présentation. Il n'y a donc aucun risque

d'altération du modéle original.

Le modele par défaut

C'est le modele appliqué lors de la création d'une
nouvelle présentation vide. Dans ce cas, on

démarre avec un bagage minimum d'éléments
prédéfinis et le reste est & construire soi-méme.
C'est la situation dans laquelle on se trouve au
lancement du programme, lorsque le démarrage
du module avec l'assistant a été désactivé.

Si le module Impress est déja lancé, vous pouvez
créer une nouvelle présentation vide par la
commande Fichier > Nouveau > Présentation
(Ctrl+N).

Pour désactiver le démarrage d'Impress avec
I'assistant, décochez simplement |'option Démarrer
avec l'assistant dans la bofte de configuration
ouverte par la commande : Outils > Options...>
OpenOffice Impress - Général.

Un modele personnalisé

Par défaut, les modéles d'origine du module sont
stockés dans le répertoire :

C:\Program Files\OO\Basis\share\template\fr\.

Les modéles créés ou installés par l'utilisateur
sont enregistrés dans le sous-dossier template de
son dossier de profil.

Utiliser un modéle existant

Pour créer une nouvelle présentation sur base
d'un modéle procédez comme suit :

1. Lancez la commande Fichier > Nouveau >
Modeéles et documents depuis la barre des
menus du programme

2. Dans la boite de dialogue Modéles et
documents, double cliguez sur licbne
Modéles.

3. Choisissez le modéle a utiliser dans la partie
centrale de la boite.

4. Validez en cliquant sur le bouton Ouvrir

Le programme charge, dans l'espace de travall,
une copie du modéle choisi, en vous laissant le
soin de la modifier et de I'étoffer jusqu'a obtention
de la présentation finale souhaitée.

Gérer les modeéles

La commande Fichier > Modeles > Gérer ...
permet d'organiser les modéles et de définir celui
gue le programme doit utiliser par défaut.

Les commandes disponibles sont contextuelles et
apparaissent lorsqu'on clique sur le bouton
Commandes ou si on clique a droite sur un objet
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2.Créer une présentation

sélectionné dans la boite (répertoire, modéle ou
document).

Gestion des modéles E3
-D Mes modéles (2] Modification des modéles par défl
[ Armigre-plans de présentation =] 5ans noml
|"5| Mer de glace
(& Présentations
[E] présentation dun nouveau pre
|E] Proposition de stratégie
Modéles i | |Dfxunenl5 v Fichier.

Un certain nombre de modéles d'arriere plan pour
Impress sont disponibles sur la Toile, par
exemple, aux adresses suivantes :

http://templates.services.openoffice.org/en/taxono
my/term/3917

http://www.smalldataproblem.org/ooextras/

Une fois vos modeéles téléchargés, vous devez
d'abord les importer dans l'un des dossiers de
stockage de la boite Gestion des modéles, avant
de pouvoir les utiliser. Cela se fait par la
commande Importer un modéle...

Les modeles stockés dans le répertoire Mes modéles
sont vos modeles personnels.

Ceux qui se trouvent dans les répertoires Arriére-
plans de présentation et Présentations sont
accessibles a tous les utilisateurs.

Importer un modele téléchargé

1. Dans la boite Gestion des modéles, désignez
le dossier dans lequel vous souhaitez importer
votre modéle.

2. Cliquez sur le bouton Commandes et

choisissez Importer un modéle .... Une
fenétre classique d'ouverture de fichiers
apparait.

3. Recherchez et sélectionnez le modele a
importer, puis cliquez sur Ouvrir. La boite
d'ouverture se referme et le modeéle se
retrouve dans le dossier sélectionné et vous
pouvez, au besoin le renommer avant de
valider par Enter.

Exporter un modele

Pour exporter un modeéle depuis un dossier de
modeles vers un autre emplacement, par exemple
le dossier Mes documents

1. Dans la boite de dialogue Gestion des
modeéles, double-cliguez sur le dossier
renfermant le modeéle a exporter. Une liste de
tous les modéles contenus dans ce dossier
apparait.

2. Sélectionnez le modele a exporter.

3. Cliquez sur le bouton Commandes et
choisissez Exporter le modéle, pour accéder
a la boite d'enregistrement Enregistrer sous.

4. Indiquez le dossier cible vers lequel
I'exportation doit se faire, puis cliquez sur le
bouton Enregistrer.

Installer des paquets de modéles

OpenOffice dispose d'une fonctionnalité appelée
Gestionnaire des extensions, qui permet
d'installer facilement, non seulement des
collections de modéles, mais encore d'autres
compléments (graphiques, macro, etc) "intégrés"
dans des fichiers portant I'extension OXT. Vous
trouverez une liste de la plupart des extensions
disponibles a cette adresse
http://extensions.services.openoffice.org/

Pour installer une extension, procédez comme
suit :

1. Téléchargez le paquet d'extensions souhaité
sur votre ordinateur.

2. Lancez la commande Outils > Gestionnaire
des extensions ..., puis cliguez sur Ajouter...
dans la boite de dialogue qui s'ouvre.

3. Dans la boite, recherchez le paquet téléchargé
a I'étape 1. Une fois celui-ci trouvé, cliquez sur
Ouvrir pour démarrer son installation. Dans
certains cas, vous serez invité a accepter un
accord de licence.

4. Lorsque l'installation est terminée, les modéeles
sont disponibles dans la boite de dialogue des
modeéles et documents (commande Fichier >
Nouveau > Modéles et documents) et
I'extension se trouve répertoriée dans la
fenétre du Gestionnaire des extensions.
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2.Créer une présentation

Une présentation existante

Vous pouvez démarrer depuis une présentation
existante, tout a fait normale, puis la modifier pour
obtenir la présentation finale souhaitée. Ce n'est
toutefois pas la meilleure fagcon de faire, car cela
nécessite un gros travail de suppression
d'informations dans la présentation source avant
de pouvoir commencer a insérer les diapositives
et contenus relatifs a la nouvelle présentation.

De plus, il faut bien veiller a enregistrer la
nouvelle présentation sous un nouveau nom afin
de ne pas écraser la présentation d'origine.

Si vous utilisez fréguemment une présentation
comme base pour en créer de nouvelles, le mieux
est de la réduire a ses masques et aux seules
diapositives de contenus recyclables, puis a
|'enregistrer comme modele de présentation par la
commande Fichier > Modeéles > Enregistrer.

Ce procédé possede I'avantage d'enregistrer
directement les masques utilisés comme nouvelles
Pages maitresses dans la rubrique Disponibles pour
utilisation du volet dédié aux pages maitresses, ce
qui facilite leur réutilisation ultérieure.

Le plan d'un document Writer

Lorsqu'un document se trouve chargé dans
Writer, la commande Fichier > Envoyer > Plan
vers Présentation crée automatiquement dans
Impress une nouvelle présentation comprenant
autant de diapositives qu'il y a de titres de niveau
1 dans le document.

Dans chaque diapositive créée, les titres des
sous-nivaux 2 sont repris comme entrées de
texte.

AutoSynthese d'un document
Writer

Lorsqu'un document est ouvert dans Writer, la
commande Fichier > Envoyer > Créer une
AutoSynthése permet d'exporter dans une
nouvelle présentation, basée sur le modéle par
défaut, les paragraphes formatés a l'aide des
styles de titre Titre 1, Titre 2, etc., sous forme de
plan intégrant en partie leurs paragraphes de
texte subordonnés.

La boite de dialogue Créer une AutoSynthése
permet de choisir le nombre de niveaux a inclure
ainsi que le nombre de sous-points par niveau.

Création d'une AutaSynthé et G
peation e Ao s ——
Propriétés
: o oK
HNiveaux de plan a inclure 3 =
Sous-peints par niveau 3 = | Annuler |
La synthése reprendra, pour chaque niveau de plan inclus, le | Aide
nombre de paragraphes indiqué. —
I

2.3. Création assistée

Si le module Impress est configuré pour démarrer
avec l'assistant (configuration par défaut), la
premiéere boite de celui-ci apparait
systématiquement au lancement du programme.

Cet Assistant de présentation (Autopilote), se
compose de 5 boites de dialogue pour une
création assistée offrant non seulement la
possibilité de lier les diapositives a un modéle
d'Arriére-plan général, mais aussi de choisir un
format de sortie (papier, transparent ou diapo) et
méme des options relatives a la projection (effets
de transition).

— Dans chaque boite de dialogue, les boutons
Suivant et Précédent facilitent la navigation
entre les différentes étapes de création et un
bouton Créer permet a tout moment de créer la
nouvelle présentation avec les options définies.

—Une option Apercu fournit une fenétre de
prévisualisation  permettant de  contrdler
I'évolution de la création.

Etape 1 : choisir un modéle

Cette étape permet de choisir le modéle sur
lequel on souhaite baser la nouvelle présentation.

En cochant l'option Ne plus afficher cet assistant,
VOUS renoncez a une création assistée mais vous
devrez alors par la suite créer toutes vos
nouvelles présentations manuellement.

Pour récupérer I'Assistant, vous devez relancer la
commande Outils > Options...> 00 Impress >
Général et cocher a nouveau l'option Démarrer
avec l'assistant.
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2.Créer une présentation

[ Assistant Présentation W — W . - =

Type

© Présentation vierge La cote belge

? A partir d'un modéle

® Duvrir une présentation existante!

Apercu

[T Ne plus afficher cet assistant

’ T )
| l Aide H Annuler “ << Précédent || Suivant >> \[ Quvrir

Les options possibles sont les suivantes :

1. Présentation vierge : avec cette option, si on
clique directement sur le bouton Créer, on
obtient une présentation vide basée sur le
modéle par défaut du programme. Ce modéle
apporte un choix de police et de taille de
caractéres, un type de puces, etc., mais il reste
minimaliste et vous oblige a réaliser
manuellement une grande partie du travail de
mise en forme de votre présentation.

2. A partir d'un modéle : la boite se modifie et
affiche la liste des modéles disponibles. Ceux-
ci peuvent se limiter a des styles de pages
appliqués a toutes les futures pages de la
présentation (option  Arriére-plans  de
présentation) ou correspondent a des
modeéles de présentations thématiques
fournissant, en plus d'un théme graphique
général (style de page), quelques diapositives
de contenus (option Présentations). La
nouvelle présentation hérite alors de toutes les
caractéristigues du modéle choisi (formats et
attributs de caractéres, type de puces, fond,
effets de transition, diapos exemples s'il y en a,
etc.).

3. Ouvrir une présentation existante pour la
projeter, limprimer, la modifier ou encore
l'utiliser comme base de départ pour la
création d'une nouvelle présentation. Dans ce
cas, le bouton Ouvrir permet d'accéder, par
défaut, au dossier Mes Documents, pour
choisir la présentation a utiliser comme base.

Etape 2 : style de page et
média de sortie

Cette boite permet de changer le style de page
choisi a I'étape précédente, et de définir un type
de média de sortie : Transparent, Papier, Ecran,
Diapo, etc.., ce qui aura une influence sur le
format de page, en particulier sur ses dimensions
et ses marges.

I

i
—
Sélectionner un style de page
Arrigre-plans de présentation
<0riginal=
Mer de glace
Selectionner un media de sortie
@ Criginal O Ecran
Transparent Diapo
= Mg o =g Apercu
O Papier
[ Aide ] [ Annuler ] [ << Précédent ] [ Suivant > ] [ Créer ]

» Si vous avez choisi un modeéle de présentation a
|'étape précédente et que le style de ses pages
ne vous convient pas, cette boite vous permet
d'en changer tout en conservant les diapositives
exemples fournies par le modéle de départ.

+ Le type de média de sortie Ecran n'est pas
adapté aux écrans larges, mais vous pouvez
modifier a tout moment la taille de vos
diapositives en mode Normal par la commande
Format > Page ...

Etape 3 : projection et
transitions

Cette fenétre permet de choisir un effet de
transition par défaut qui accompagnera le
passage d'une diapositive a l'autre lors de la
projection, et de définir sa vitesse d'exécution
dans une liste déroulante.

On peut encore choisir ici entre un mode de
projection Standard (déroulement du début a la
fin, transition entre les diapos manuelle, par
exemple a l'aide de la souris) ou Automatique.

L'option Afficher le logo affiche le logo "Créé avec
OpenOffice.org" sur la page de pause.
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2.Créer une présentation

Assistant Présentation (Proposition de stratégie)

Sélectionner Lne transition entre les diapos

e

Sélectionner |z type de présentation
® Standard

QO Automatique

Durée d'affichage 00:00: 10

Durée de la pause  |go:oo: 1o [¥] apercu

Afficher e logo

[ Aide } [ Annuler } [ «« Précéedent J L Suivant =»i ] [ Créer ]

Si vous décidez de travailler en mode
Automatique, vous devez définir :

- La durée d'affichage a appliquer, c'est a dire la
durée d'exposition de chaque diapo avant le
passage a la diapo suivante. Vous pouvez bien
sQr redéfinir ultérieurement ce minutage.

- La durée de la pause correspond au temps de
pause a appliquer entre la fin et le redémarrage
de la projection, ce qui revient a définir la durée
d'exposition de la page de pause qui s'affiche
entre deux projections successives.

Etape 4 : lignes générales

Les informations saisies dans les champs de ce
formulaire sont reproduites sur la diapositive de
titre de la présentation.

Assistant Présentation (Proposition de stratégie)

Décrivez vos idées fondamentales
Quel est votre nom ou celui de votre société ?

Quel est e sujet de la présentation ?

D'autres idees 3 traiter ?

>

i

[ Aide J [ Annuler ] [ < < Précédent J [ Suivant = J [ Créer J

Etape 5 : éléments a intégrer

Si vous avez choisi de démarrer depuis un
modéle de présentation plutét qu'un modeéle
d'arriere-plan, vous pouvez choisir ici les pages
du modeles a intégrer et décocher les autres. Une
option permet également de créer un sommaire
de la présentation.

Assistant Présentation (Proposition de stratégie)

Selectionnez les pages souhaitées

Introduction

[ Obiectif 4 lang terme
[“]La situation actuele

L 'gvolution
[CEventueles atematives
Recommandation

Apercu

Créer un sormmaire

[ Aide J [ Annuler J [ << Précédent J Suivant =

A lissue de cette étape, le bouton Créer fait
apparaitre la nouvelle présentation, avec toutes
les options définies dans les boites de I'Assistant.

2.4. Enregistrement

Une fois la présentation créée, enregistrez-la
avant de procéder aux modifications qui
conduiront & sa version finale.

Cet enregistrement se fait par la commande
Fichier > Enregistrer sous... en indiquant dans
la boite d'enregistrement le nom de fichier choisi
ainsi que le chemin vers le répertoire de
sauvegarde.

Une présentation s'enregistre toujours dans le mode
d'affichage  actif. Ainsi, si la  procédure
d'enregistrement a été lancée alors qu'on se
trouvait en mode d'affichage Normal, c'est dans ce
mode que la présentation s'ouvrira lors de son
prochain chargement.

2.5. Editer le plan de la

présentation

A la sortie de I'Assistant de création, on dispose
d'une présentation quasi vide, mais dont on a
déja défini le design général en choisissant le
modele d'arriere-plan (Page maitresse) a
appliquer a toutes ses diapositives.

Cette présentation reste trés basique et limitée,
soit a une seule diapositive, soit a quelques
diapositives de contenus exemple, si vous avez
basé votre création sur un modéle de
présentation plutét que sur un modele d'arriére-
plan.
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2.Créer une présentation

Pourquoi créer un plan ?

Vous pourriez trés bien, a ce stade, basculer en
mode d'affichage Normal pour procéder a
l'insertion de nouvelles diapositives et a la
création de leur contenu, mais cette méthode a le
gros désavantage de vous faire rapidement
perdre la vision globale de votre travail.

Le travail en mode Plan évite ce probléeme et vous
offre d'autres avantages :

- En affichant la présentation sous forme de plan,
avec le titre des diapositives et les idées
principales qui s'y trouvent développées, ce
mode vous aide a mieux structurer vos idées.
Ce sont en effet les textes principaux qui
apparaissent en mode Plan, pas ceux gue vous

insérez sur vos diapositives a lintérieur de
boites de texte.

-1l permet un développement rapide de la
présentation en offrant la possibilité d'éditer et
de modifier aisément sa structure.

Travailler en mode Plan

Les diapositives créées en mode Plan héritent
toutes d'une mise en page commune appelée
Titre, contenu qui est la plus générale, avec un
espace réservé pour le titre et un autre pour le
contenu.

Vous pouvez aussi créer des diapositives
simplement titrées, a compléter plus tard, en mode
Normal, par insertion d'objets divers.

Lorsque vous éditez le texte de vos diapositives
dans ce mode, les différents niveaux du plan sont
automatiquement formatés a l'aide de styles
automatiques de la catégorie Styles de
présentation dans le Styliste. Ce sont les seuls

styles actifs en Mode Plan.

— Titre s'applique automatiquement aux titres des
diapositives.

—Plan 1 a 9 : ces styles sont automatiquement
appligué aux différents niveaux des listes
d'arguments constituant le texte principal des
diapositives.

Le volet Diapos en mode Plan

Il affiche la liste des diapositives, sous forme de
vignettes, avec leur contenu texte. Cela permet
de garder un ceil sur les contenus et de s'assurer
qu'ils ne sont pas excessifs.

Un certain nombre de taches peuvent étre
réalisées depuis ce volet, par lintermédiaire de
commandes contenues dans le menu contextuel
des vignettes : ajouter une nouvelle diapo a la
suite de la diapo active, supprimer la diapo
courante, lui associer un effet de transition, la
masquer, couper, copier, coller.

Le volet Diapos du mode Plan ne permet pas :

+ de changer le style de la diapo active en lui
associant une autre Page maitresse ;

» de choisir une mise en page pour la diapo active.

Rédiger les textes

La saisie de texte se fait de la méme maniere que
pour une liste a puces dans Writer : la frappe de
la touche Enter provoque la rupture de ligne avec
commencement d'un nouveau paragraphe de
méme niveau que le précédent, alors que la
combinaison de touches Shift + Enter permet de
rajouter une ligne supplémentaire a un
paragraphe.

Lorsqu'il s'agit d'ajouter une nouvelle diapositive ne
devant pas contenir de liste d'arguments, mais
d'autres objets, il suffit simplement de saisir son
titre, puis de la compléter plus tard en mode
Normal.

Gérer les niveaux du plan

La hiérarchie des niveaux est contrélée au clavier
par la touche Tab, ou la combinaison de touches
Shift+Tab. On peut également utiliser les boutons
situés dans la barre d'outils Formatage du texte,
comme montré ci-dessous.

T !

Ces boutons permettent respectivement de
hausser ou d'abaisser les niveaux, ou encore de
déplacer des éléments vers le haut ou le bas,
sans changer leur position hiérarchique.

On peut aussi modifier I'ordre de succession des
arguments graphiquement, en les déplacant par un
cliquer glisser sur la puce qui les précede.

Mettre en forme les textes

La mise en forme des niveaux de plan résulte de
lapplication  automatique de  styles de
présentation Titre, Sous-titre, Plan 1, Plan 2, etc.
hérités du modele sur lequel la présentation est
basée.
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2.Créer une présentation

Ces styles sont affichés dans le Styliste (F11) et
vous pouvez les modifier en cliqguant a droite sur
leur nom pour accéder a leur commande de
modification.

Il est bien sUr possible de formater directement les
textes a l'aide des boutons présents dans la barre
d'outils Formatage de texte ou dans le volet
Propriétés de la barre latérale (AOO 4.0), mais cette
facon de faire n'est pas recommandée. Il est
préférable d'effectuer les modifications directement
au niveau des styles appliqués pour s'assurer d'une
mise en forme homogene.

Gérer I'affichage du plan

La barre d'outils Plan dispose d'outils spécifiques
pour gérer l'affichage des niveaux du plan. Ces
outils permettent, par exemple, de les réduire aux
seuls titres des diapositives, ou encore de
masquer le formatage des textes.

Le bouton Diaporama permet a tout moment de
démarrer la projection en mode plein écran, a
partir de la diapositive courante. Le retour au
mode Plan se fait simplement en appuyant sur la
touche Escape.

Ci-dessous une copie d'écran de la barre avec un
court descriptif de ses fonctionnalités.

12 3 4 56 T

Premier niveau

Tous les niveaux
Masquer les sous-points
Afficher les sous-points
(Dés)activer le formatage
Mode Noir et blanc

N ogahrwdhpRE

Diaporama (F5)

2.6. Compléter la présentation

Une fois le plan général terminé, on peut basculer
vers un affichage en mode Normal pour insérer
dans les diapositives des contenus graphiques :
images, tableaux, organigrammes, diagrammes,
ou pour insérer de nouvelles diapositives
(principalement celles destinées a recevoir des
contenus graphiques).

La procédure d'insertion d'une nouvelle diapo
dans ce mode se déroule en 3 étapes :

1. Insertion de la nouvelle diapositive a la suite
de la diapositive active. Cette nouvelle
diapositive hérite automatiquement du modéle
de mise en page et du style de page de la
diapositive active au moment de l'insertion.

2. Choix du type de mise en page, si celui
hérité de la diapositive active au moment de
l'insertion n'est pas adéquat.

3. Changement de style de page, par exemple,
si la nouvelle diapo est destinée & marquer
une transition ou une rupture dans le théme
graphique général de la présentation.

Insérer une nouvelle
diapositive

Pour insérer une nouvelle diapositive, en mode
d'affichage Normal, a la suite de la diapo
courante, utilisez la commande Insertion > Diapo
ou cliquez sur l'icbne Diapo dans la barre d'outils
Présentation.

La nouvelle diapo insérée hérite automatiquement
de la mise en page de celle qui la précéde, mais
vous pouvez en choisir une autre, si elle n'est pas
adaptée au contenu que vous souhaitez insérer.

Pour insérer une copie de la page active utilisez la
commande Insertion > Dupliquer la diapo.

La barre d'outils Présentation ne dispose pas d'une
commande de suppression de diapositive. Pour
supprimer une diapositive, utilisez la commande
contextuelle Supprimer la diapo présente dans le
menu contextuel des vignettes du volet Diapositives
ou du mode Trieuse de diapositives.

Importer des diapositives

Pour importer des diapositives provenant d'une
autre présentation :

1) Lancez la commande Insertion > Fichier...
pour ouvrir la boite Insérer un fichier, puis
sélectionnez la présentation source et cliquez sur
le bouton Ouvrir.

2) Dans la boite Insérer des pages ou des
d'objets, cliquez sur le caractére "+" apparaissant
sur la gauche du chemin d'accés a la présentation
source, pour afficher la liste de ses pages.

Lorsqu'une page contient des objets, un caractere
"+" apparait également sur sa gauche, permettant
d'en afficher la liste.
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2.Créer une présentation

3) Sélectionnez la ou les page(s) ou l'objet a
importer puis validez par OK. Si vous n'indiquez
rien, c'est toute la présentation source qui est
importée.

4) La ou les page(s) sélectionnée(s) s'insere(nt)
dans la présentation cible, a la suite de la page
active. S'il s'agit d'un objet, il est importé dans la
page active.

Insérer des pages/des abjets

| G Pl IDomumerts % g 420settng & |

| Thre =
[ mtroduction

D Chiecti & long berme
[ La situation actushs
[ Léwabition
!:I Eventusles stematives
% . I »

[Cuen

[¥] Supprimer les arritre-plars jutbisées

|

On peut insérer plusieurs pages en méme temps en
les sélectionnant ensembles dans la boite avec les
touches Shift ou Ctrl.

Si on coche l'option Lien, la page est insérée comme
lien et actualisée lors de toute modification du
fichier source.

Importer des diapositives a la
souris

Procédez comme suit :

1. Affichez la présentation source et la
présentation cible dans deux fenétre
juxtaposées, en mode Trieuse de diapositives.

2. Faites glisser les diapositives de la
présentation source vers la présentation cible
a l'aide de la souris en maintenant la touche
Ctrl enfoncée.

3. Une fois les diapos importées, adaptez leur
arriere-plan a celui de la présentation cible, en
les liant a la méme page maitresse.

Choisir la mise en page

Pour assurer une disposition harmonieuse du
contenu des diapositives, 12 modeles de mise en
page prédéfinis sont a disposition dans l'onglet
Mises en pages du volet Taches, ou depuis le
volet Propriétés dans la barre latérale sous AOO
4.0.

Ces modeéles vont d'un modele de diapo vierge
jusqu'a celui intégrant 6 espaces réservés en plus
de celui dédié au titre de la diapositive et ils
peuvent étre a tout moment appligués a une
diapositive existante affichée en mode Normal.
Dans certains cas toutefois, il sera nécessaire

d'adapter le contenu de la diapositive a la
nouvelle mise en page choisie.

Pour attribuer une mise en page a une diapo,
|'afficher dans I'espace de travail en mode Normal,
puis cliquer simplement sur le modéle souhaité dans
le volet Téches.
Il n'est pas possible de créer ses propres modeéles de
mises en page.

Diapo vierge est un modéle sans espaces
réservés prédéfinis, qui laisse une entiére liberté
de mise en page. Si des textes doivent étre
insérés, ils doivent obligatoirement étre introduits
dans des boites de texte.

Titre uniquement : modéle destiné a la page de
titre générale de la présentation. Le texte entré
recoit automatiquement le formatage du style de
présentation Titre.

Diapo-titre, integre également un cadre pour un
sous-titre. On peut l'utiliser pour la diapositive de
titre de la présentation ou comme diapositive de
titre pour ses différentes parties. Le texte saisi
dans le cadre réservé au titre est formaté a l'aide
du style de présentation Titre, alors que sous-titre
est formaté avec le style de présentation Sous-
titre. L'application de ces styles est automatique.

Texte centré est plutét un modele de mise en
page destiné aux diapositives introduisant les
différentes parties d'une présentation. Le style de
présentation Sous-titre est automatiquement
utilisé pour formater le texte entré dans ce modéle
de mise en page.

Titre, contenu est un modéle général de mise en
page qui renferme, en plus d'un cadre de titre
préformaté avec le style de présentation Titre, un
espace réservé dans lequel les textes sont
automatiquement formatés, selon leur niveau de
plan, a I'aide des styles de présentation Plan 1 a
9. Cet espace réservé contient en son centre un
groupe de 4 icbnes permettant l'insertion de types
de contenus tableau, diagramme, image, ou
vidéo.

Vous pouvez également recourir au menu Insertion
pour insérer toutes sortes d'objets dans vos
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2.Créer une présentation

diapositives, a l'intérieur d'espaces réservés ou pas.
La taille des images insérées s'adapte a l'espace
disponible dans I'espace réservé ou on les introduit.

Les autres modeles de mise en page fonctionnent
sur le méme principe, mais avec des nombres
d'espaces réservés différents et des variantes
dans leur disposition, comme montré ci-dessous
avec le modele Titre, 4 contenus.

Cliquez pour ajouter un titre

* Cliquez pour ajouter
un texte

* Cliquez pour ajouter

un texte

7 iy il
I H] H

* Cliquez pour ajouter
un texte

* Cliquez pour ajouter

un texte

B il EE i
O H (=)=)

Les espaces réservés sont déplacables et
peuvent étre redimensionnés a la souris, comme
les cadres, lorsqu'ils sont sélectionnés d'un
simple clic. On peut également les supprimer
comme des objets graphiques normaux.

Lorsqu'un espace réservé est sélectionné, des
poignées de redimensionnement  vertes
apparaissent sur sa bordure de sélection. Si on
cligue une seconde fois sur l'objet, des poignées
rouges apparaissent pour permettre de le faire
tourner par ses poignées d'angles.

Il est toujours possible de rajouter du texte a
posteriori sur n'importe quelle diapositive en faisant
appel au bouton Texte, situé dans la barre d'outils
Dessin. Il permet de tracer librement une zone de
texte dans une diapositive affichée en mode
Normal.

Changer de style de page

Toute nouvelle diapositive insérée hérite du style
graphigue en vigueur dans l'ensemble de la
présentation. Celui-ci provient de la Page
maitresse utilisée comme modele d'arriere-plan
lors de la création de la présentation. Il est
toutefois possible de changer ce style pour une
nouvelle page insérée, par exemple lorsqu'on

veut lui faire jouer un réle de transition ou de
rupture dans la présentation.

1. Dans la barre d'outils Présentation, cliquez sur
le bouton Conception de diapo pour ouvrir la
boite de dialogue qui permet d'affecter un
nouveau style graphique a cette diapo. Si
plusieurs styles sont utilisés dans la
présentation, cliquez sur l'un de ceux listés
dans la boite de dialogue.

2. Sivous souhaitez utiliser un style extérieur a la
présentation, cliquez sur le bouton Charger
pour ouvrir la boite de dialogue Charger un
style de diapo. Dans cette nouvelle boite,
sélectionnez alors un élément dans la section
Catégorie, puis un modele dans la catégorie
choisie.

3. Cliquez sur le bouton Plus pour obtenir une
fenétre  supplémentaire  prévisualisant le
résultat obtenu avec le modéle choisi, si vous
cochez la case Apercu. Une fois que vous étes
satisfait , cliquez sur le bouton OK.

4. La boite Charger un style de page se referme
automatiquement. Dans la boite Style de page,
il reste alors a cliquer sur le nouveau style
chargé, puis a valider par OK pour appliquer
son théme graphique a la diapositive active.
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Dans ce chapitre, nous allons passer en revue les
différents contenus qui peuvent étre insérés dans
les diapositives en mode d'affichage Normal, puis
nous terminerons par une bréeve description des

effets qu'on peut leur appliquer pour rendre le
diaporama plus vivant.

L'insertion d'objets Fontwork, Images Map et
diagrammes est commune a tous les modules de la
suite OpenOffice. Le sujet est traité dans le module
d'introduction générale Découvrir OpenOffice.

3.1. Les textes

L'insertion de texte dans une diapositive se fait
classiqguement par saisie directe au clavier ou par
copier-coller d'un texte depuis le presse-papiers
de Windows.

Toutefois, cette insertion ne peut se faire, dans
une diapositive, qu'a lintérieur d'espaces
réservés fournis par le modéle de mise en page
appliqué, ou a l'intérieur d'objets de texte, comme
les formes dessinées ou les boites de texte
tracées a l'aide d'outils de la barre Dessin.

Lorsque le texte est inséré par collage depuis le
presse-papiers de Windows, il faut gommer son
formatage d'origine pour éviter qu'il n'interfére
avec celui prévu dans l'espace réservé ou l'objet
de texte auquel il est destiné. Deux méthodes
sont possibles pour réaliser cette opération :

— coller normalement le texte, puis le sélectionner
et le débarrasser de ses propres attributs par la
commande Formatage par défaut présente
dans son menu contextuel ;

— coller le texte directement au format texte brut

par la commande de collage spécial Texte non
formaté.

Dans un espace réservé

Cliquez sur lindication Cliquez pour ajouter un
texte puis commencez la saisie de la méme
maniére qu'en mode Plan.

+ Lorsqu'un espace réservé se trouve en mode
Edition, sa bordure est hachurée.

Seuls les textes saisis dans des espaces réservés
sont visibles en mode Plan. Les textes saisis dans
des boites de textes n'apparaissent pas.

Les niveaux de plan sont automatiquement
formatés a l'aide des styles de présentation Plan
1 a 9 hérités de la page maitresse a laquelle la
diapositive est liée. Vous pouvez parfaitement
modifier ces styles s'ils ne vous conviennent pas.
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3.Insérer des objets

Vous pouvez également appliquer des formatages
directs a vos textes, mais cette facon de faire doit
rester exceptionnelle, si vous souhaitez conserver
une mise en forme homogene de vos textes.

Dans une boite de texte

Procédez comme suit pour créer une boite de
texte libre dans la diapositive active :

1. Dans la barre d'outils Dessin, cliquez sur
l'icbne Texte, puis dessinez sur votre diapo le
cadre de texte souhaité. Celui-ci s'entoure
d'une bordure hachurée et un curseur d'édition
clignote a l'intérieur, signifiant qu'il est en mode

édition et prét a recevoir une entrée de texte
:/;{////////////x%

=
i La barre d'outils Formatage du
texte s'affiche automatiqguement, avec les outils
permettant d'appliquer un formatage direct au
texte saisi dans la boite.

2. Une fois votre saisie terminée, cliquez en
dehors de la zone pour quitter la sélection. Si
Vous ne saisissez rien, la zone de texte
disparait automatiquement dés que vous
cliguez en dehors d'elle.

3. Pour adapter la largeur de la zone de texte a
son contenu, sélectionnez-la, puis lancez la
commande Format > Position et taille pour
accéder a l'option Adapter la largeur au texte
et pouvoir l'activer.

Par défaut, le texte saisi dans ces boites est
formaté avec le style Standard appartenant a la
catégorie des Styles d'images dans le Styliste.
Vous pouvez modifier ce style s'il ne vous satisfait
pas pleinement ou formater directement le texte a
l'aide des outils de la barre Formatage du texte.

Déplacer une zone de texte

Il reste maintenant a positionner avec précision la
boite de texte sur la diapositive.

1. Cliquez sur le texte de la boite : la zone de
texte bascule en mode Edition, avec une
bordure grise et un curseur d'édition a
l'intérieur.

2. Pointez sur la bordure grise jusqu'a ce que le
pointeur de la souris change de forme et se
transforme en une fleche a quatre pointes. A
ce moment, cliquez et glissez pour déplacer la
zone de texte jusqu'a la position finale
souhaitée. Si vous procédez en maintenant la

touche Ctrl enfoncée, vous réalisez une copie

de votre boite de texte et non un déplacement.
3. Relachez le bouton de la souris lorsque la

zone de texte est a I'emplacement souhaité.

Faire tourner et redimensionner une zone
de texte

1. Cliquez sur le texte de la boite : la zone de
texte est maintenant en mode d'édition, avec
une bordure grise et un curseur d'édition a
l'intérieur.

2. Cliguez sur la bordure grise de la boite : des
poignées rouges apparaissent sur le pourtour
de la boite. Les poignées d'angle permettent
de la faire pivoter a l'aide de la souris.

3. Cliguez une nouvelle fois sur la bordure grise

de la boite : des poignées de

redimensionnement cyan apparaissent alors
sur son pourtour et un redimensionnement est
alors possible a l'aide de la souris.

Vous disposez encore de la commande contextuelle

Alignement  pour aligner verticalement ou

horizontalement une zone de texte sur une
diapositive.

La boite Position et taille

La commande Format > Position et taille (F4)
ou la commande contextuelle équivalente d'une
boite de texte sélectionnée ouvrent une boite
permettant de contréler avec précision la taille,
position et le redimensionnement d'une zone de
texte.

Si vous travaillez avec AOO 4.0, cette boite est
également disponible depuis le lanceur de boite
de dialogue figurant dans le panneau Position et
taille du volet Propriétés de la barre latérale,
comme montré ci-dessous.

=| Position and Size O
Horizontal: Vertical:
11.40cm 14.60em

Width:

4.60cm

Supprimer une zone de texte

1. Sélectionnez la boite de texte (poignées
rouges ou cyan visibles sur son contour)

2. Appuyez sur la touche Delete au clavier.

© 2012 - 2013 G. Waterval

Version : 26/04/13

Apache licence, Version 2.0

0004Kids - Apache OpenOffice™ - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

29/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

3.Insérer des objets

Dans une image ou une forme

Qu'elle soit vectorielle ou bitmap, une image sur
laquelle on effectue un double clic bascule en
mode Edition pour permettre la saisie d'un texte a
l'intérieur. Le texte entré peut étre formaté
manuellement, par exemple depuis la barre
d'outils Formatage du texte, ou a l'aide des styles
d'images a disposition dans le Styliste. Notez que
vous devrez parfois jouer sur les couleurs et la
transparence pour obtenir une bonne visibilité du
texte.

— A tout le texte de l'objet si ce dernier est
sélectionné avant le lancement de la commande
de formatage.

— Au passage de texte sélectionné a l'intérieur de
I'objet avant le lancement de la commande de
formatage.

Vous pouvez a tout moment enlever cette couche
de formatage additionnel et retrouver le formatage
du style de base en sélectionnant le texte a
"nettoyer" puis en lancant la commande Format >
Formatage par défaut.

Pour obtenir un texte s'étalant sur plusieurs lignes,
activez I'option Aligner au contour dans la boite de
dialogue ouverte par la commande contextuelle
Texte.

Pour resserrer le texte et le faire tenir en entier dans
I'image ou la forme, activez I'option Adapter au
cadre dans la bofte de dialogue Texte.

Formatage des textes

L'apparence des textes résulte des styles qui leur
sont appliqués et des éventuels formatages
manuels qu'on y a ajoutés.

Application de styles automatiques

Les textes saisis dans les espaces réserveés, les
boites de texte, les formes et les cadres de notes
sont automatiquement formatés par des styles qui
leur sont automatiquement appliqués.

— Styles de présentation Titre, Sous-titre, Titre 1 a
9 pour les différents niveaux de plan des textes
saisis dans les espaces réservés de texte.

— Style de présentation Notes pour les textes
saisis en mode d'affichage Notes.

— Style d'image Standard pour les textes saisis
dans les boites de texte, les formes et les
images insérées.

Si vous modifiez des styles, les modifications sont
automatiquement répercutées partout ou ces
styles sont appliqués et également aux nouveaux
textes introduits par la suite.

Application d'un formatage manuel

Vous pouvez ajouter un formatage manuel a vos
textes, par dessus celui hérité du style. Cette
madification locale s'applique :

Si vous utilisez AOO 4.0, prenez I'habitude de
consulter le volet Propriétés de la barre latérale. Il
vous offre généralement un accés facile a toutes les
commandes dont vous avez besoin pour agir sur
votre sélection.

La commande Format > Texte

Cette commande ouvre la boite de dialogue Texte
qui renferme, sous deux onglets, les options
permettant de définir la maniére dont se comporte
le texte inséré dans une forme (onglet Texte) et
les effets spéciaux qui peuvent lui étre appliqués
(onglet Animation de texte).

Onglet "Texte"

Les options ne sont pas toutes disponibles, car
elles dépendent du genre d'objet dans lequel le
texte est inséré.

Texte | Animation de texte

Texte
Adapter la largeur au texte I Renvoyer le texte a la ligne dans la forme
Adapter la hauteur au texte [¥] Adapter la forme au texte
[ Adapter au cadre
[7 Ajuster au contour

Espacement avec les bordures Ancre de texte
Gauche 0.00cm El * = £
Droite 0.00cm E l s l
Haut 0.00cm E l l
= E Pleine largeur

— Adapter la largeur au texte : la forme s'adapte
en largeur au texte inséré.

— Renvoyer le texte a la ligne dans la forme : un
saut de ligne est automatiquement effectué
lorsque le texte atteint le bord droit de la forme.

— Adapter la hauteur au texte: augmente
automatiquement la hauteur de I'objet pour
I'adapter au texte qu'il doit contenir.
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— Adapter la forme au texte : adapte la taille d'une
forme personnalisée au texte.

— Adapter au cadre : étend le texte de maniéere a
remplir tout I'espace disponible.

— Adapter au contour : permet au texte de suivre
une ligne courbe.

— Espacement avec les bordures : spécifie I'écart
a maintenir entre la bordure de la forme ou de la
ligne et le texte.

— Ancre de texte: cocher le point d'ancrage
souhaité dans la grille modéle. La case a cocher
Pleine largeur demande a ce que l'ancrage se
fasse sur toute la largeur de la forme.

Onglet "Animation de texte"

Texte (Animation de texte ‘

Effets d'animation de texte

Effet Défiler - Orientation E
Propriétés

Texte visible au départ

Texte visible a l'arrét

Cycles d'animation

Pas de progression

Pixels 1 Pixel
Délai

Cet onglet permet de choisir entre 4 effets
d'animation de texte avec direction spécifiée en
choisissant l'un des quatre boutons fléchés sur la
droite.

3.2. Les illustrations

Il existe deux types d'images : les images bitmaps
(photos ou images scannées) et les vectorielles
(dessins ou schémas). Dans les deux cas :

—Un simple clic de souris sur une image la
sélectionne et fait apparaitre sur son pourtour
des poignées de redimensionnement vertes
permettant de modifier sa taille a la souris.

— Un second clic sur une image déja sélectionnée,
fait apparaitre sur son pourtour des poignées
rouges permettant de la basculer (poignées
latérales) ou de la faire tourner autour d'un axe
déplacable (poignées d'angle).

— Un double clic sur une image la bascule en
mode Edition et fait apparaitre un curseur
d'édition a l'intérieur.

Dans les 3 cas précédents, en pointant sur

l'image, on peut obtenir un curseur en forme de

croix fléchée qui permet de la déplacer a l'aide de
la souris.

3.3. Les dessins

Les images vectorielles (dessins) sont plus
Iégeres que les images bitmaps et on peut les
agrandir ou les réduire sans perte de qualité.

Dans OpenOffice, c'est le module Draw qui
permet de les créer, mais Impress intégre
également, dans sa barre d'outils Dessin, des
fonctionnalités pour la création directe de formes
simples dans les diapositives.

Barre d'outils Dessin

Elle regroupe les principaux outils dédiés a la
création d'objets graphiques. Si elle n'est pas
affichée, utilisez la commande Affichage > Barre
d'outils > Dessin.

/A E@L TR & @ -« @F ¥-%k-

La barre d'outils Dessin propose :

— une série de formes de base : Ligne, Rectangle,
Ellipse, Texte ;

—une série de formes prédéfinies classées en
diverses catégories : Courbes, Connecteurs,
Formes de base, Formes des symboles,
Fléches pleines, Organigrammes, Légendes,
Etoiles. Les icones de ces catégories proposent
une palette de variantes lorsqu'on clique sur la
pointe de fleche située a leur droite. Ces
palettes peuvent étre déplacées dans l'espace
de travail sous forme de fenétre flottantes.

Dessiner des formes
Pour créer des formes et des lignes :

— Sélectionnez I'outil ligne ou forme souhaité.
— Cliquez et glissez pour créer I'objet sur la diapo

— Lors du dessin d'un polygone, gardez la touche
Shift enfoncée pendant le tracé si vous
souhaitez restreindre I'angle entre les segments
a des multiples de 45 degrés. Terminez le tracé
par un double sur la derniére partie du segment.
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3.Insérer des objets

Lors du dessin de certaines formes, un ou plusieurs
points jaunes peuvent accompagner les poignées de
redimensionnement. En les glissant avec la souris,
on peut obtenir certains effets dépendant de la
forme a laquelle on les applique. Par exemple, ils
permettent de transformer un hexagone en losange
ou en rectangle, ou encore de modifier la taille de
secteurs de cercle.

Les attributs par défaut

Toute forme dessinée posséde des attributs dits
"par défaut" (couleur de remplissage, couleur et
épaisseur du trait constituant la bordure, etc.).

Ces attributs sont hérités du style d'images
Standard appliqué automatiquement aux objets
graphigues des leur création. Si on modifie ce
style, les modifications se  répercutent
automatiquement a tous les objets liés a ce style
et a tous ceux construits par la suite.

Le formatage direct

Les dessins peuvent étre formatés a l'aide des
outils de la barre Ligne et remplissage ou en
passant par les commandes de leur menu
contextuel.

Ligne et remplissage v X
f - col~]|{000cm | [ Gris =]
2 ‘Couleur |ZI|:| Bleu 9 El =

Dans ce cas, les maodifications ne s'appliquent

gu'a I'objet lui-méme et ne sont pas répercutées
sur les formes tracées par la suite.

Si vous utilisez AOO 4.0 la plupart de ces
commandes de formatage seront également a
disposition dans le volet Propriétés de la barre
latérale.

Aligner des objets

On commence par sélectionner tous les objets a
aligner (au lasso ou en combinaison avec la
touche Shift) puis on utilise la commande
contextuelle Alignement pour définir le type
d'alignement a réaliser.

— Alignement horizontal : gauche, centre, droit
— Alignement vertical : haut, milieu, bas
Gérer I'empilement des objets

Lorsqu'on dessine ou insére des objets
graphiques, ils s'empilent verticalement dans

l'ordre inverse de leur création (le dernier créé se
trouvant en sommet de pile). Les objets peuvent
ainsi se chevaucher et méme se cacher les uns
derriére les autres. On peut décider de leur ordre
d'empilement par la commande contextuelle

Organiser ou la commande Format > Organiser.

— Envoyer a l'avant l'objet sélectionné est
envoyé au-dessus de la pile.

- Envoyer vers l'avant I'objet sélectionné
remonte d'un niveau dans la pile.

— Envoyer a l'arriéere : l'objet sélectionné est
déplacé tout en bas dans la pile.

— Envoyer vers l'arriére : I'objet descend d'un
niveau vers le bas dans la pile.

— Devant I'objet amene l'objet sélectionné
devant le second objet sélectionné. A cette
occasion le pointeur prend la forme d'une main
pour permettre d'indiquer le second objet.

— Derriére Il'objet : améne l'objet sélectionné
derriere le second objet sélectionné. Comme
précédemment un pointeur main permet de
désigner le second objet.

- Inverser inverse l'ordre d'empilement des
deux objets sélectionnés.

Refléter les objets

Pour retourner un objet ou un groupe sélectionné,
utiliser les commandes Refléter > Verticalement
et Refléter > Horizontalement.

L'objet (ou le groupe) bascule alors autour d'un
axe imaginaire (respectivement horizontal et
vertical) passant par son centre.

Faire tourner les objets

La procédure est identique a celle décrite pour
faire pivoter les images.

Gérer couleur et transparence

On peut laisser le fond des formes et zones de
texte sans remplissage pour les rendre
transparents et pouvoir ainsi les empiler sans
effet de masquage.

Les bordures (traits ou lignes de contour des
formes) peuvent également étre laissées
transparentes.

Dans une zone de texte, on peut remplir en blanc
le rectangle contenant le texte, pour améliorer sa

© 2012 - 2013 G. Waterval

Version : 26/04/13

0004Kids - Apache OpenOffice

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

Apache licence, Version 2.0
- OOoLight

™

32/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

3.Insérer des objets

lisibilité, ou le laisser sans remplissage, s'il s'agit
de le placer devant une forme pour le faire
apparaitre en surimpression.

On peut également rendre une forme semi-
transparente, pour conserver une trace de sa
couleur d'origine tout en permettant d'apercevoir
ce qui se trouve derriére.

Les connecteurs

Les connecteurs sont des lignes qui peuvent
s'ancrer sur les objets graphiques a des endroits
particuliers appelés points de collage. lIs
permettent de relier des boites dans les schémas,
organigrammes, diagrammes de flux, etc. et
restent solidaires de celles-ci lorsqu'on les
déplace.

L'outil Connecteur dans la barre d'outils Dessin
propose, dans une palette, une collection de
connecteurs prédéfinis qui difféerent dans leur
forme (direct, linéaire, incurvé) ainsi que dans
celle de leurs extrémités.

Relier deux objets

Lorsque le curseur est a proximité du premier
objet auquel il doit s'ancrer, le pourtour de la
forme apparait en pointillés et des petits carrés
pointillés permettent de localiser les points de
collage possibles. Il suffit alors d'en choisir un
puis de cliquer sans relacher la souris pour
attacher le connecteur a ce point. Ensuite,
toujours avec le bouton gauche de la souris
enfoncé, on tire le connecteur vers le deuxieme
objet a relier et on choisit sur celui-ci le point de
collage a utiliser pour terminer la liaison entre les
deux formes. C'est seulement a ce moment qu'on
relache le bouton de la souris.

La barre d'outils Points de collage

Chaque forme possede un nombre prédéfini de
points de collage, mais on peut en rajouter et
méme les éditer, en utilisant la barre d'outils Point
de collage.

Points de collage > x
ﬁl ] E [t @ Br ¥ ¥ )y ey e

Utilisez le premier outil pour insérer un nouveau
point de collage, et les quatre suivants pour
définir la direction de sortie de l'extrémité du
connecteur au point de collage. L'icobne Point de

collage relatif doit étre activée pour maintenir la
position relative du point de collage lors du
redimensionnement d'un objet. Lorsque cette
icone est désactivée, les six derniéres icones de
la barre d'outils deviennent actives et permettent
de fixer la position du point de collage durant le
redimensionnement de l'objet.

Gérer les points de collage

Pour ajouter un nouveau point de collage a une
forme, procédez comme suit :

1. Affichez la barre d'outils Point de collage.

2. Activez l'outil Points de collage dans la barre
d'outils Dessin.

3. Sélectionnez la forme.

4. Cliquez sur le premier bouton de la barre
d'outils Points de collage.

5. Cliquez sur le pourtour de la forme a I'endroit
ou vous souhaitez insérer le nouveau point de
collage.

Pour supprimer un point de collage :

1. Sélectionnez l'outil Point de collage a partir
de la barre de Dessin pour afficher les points
de collage de toutes les formes présentes
dans la diapositive active.

2. Sélectionnez le point de collage a supprimer
puis appuyez sur la touche Delete.

Pour déplacer un point de collage prédéfini ou
nouvellement inséré :

1. Sélectionnez l'outil Point de collage & partir
de la barre de Dessin. Les points de collage de
toutes les formes présentes dans la diapositive
en cours deviennent visibles.

2. Cliguez sur le point de collage que vous
souhaitez déplacer. Le point de collage doit
étre maintenant mis en évidence.

3. Gardez le bouton de la souris enfoncé et

glissez le point de collage jusqu'a la position

souhaitée, puis relachez le bouton de la souris.

Par défaut, les points de collage sont placés sur la

grille. Pour obtenir un réglage plus fin de la position

d'un point de collage, appuyez sur la touche Alt

pendant le déplacement du point de collage vers sa
nouvelle position.

Formatage des connecteurs

Les connecteurs peuvent étre formatés
manuellement par leur commande contextuelle

© 2012 - 2013 G. Waterval

Version : 26/04/13

0004Kids - Apache OpenOffice

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

Apache licence, Version 2.0
- OOolLight

™

33/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

3.Insérer des objets

Connecteur ou par application d'un style d'image
dédié.

Dans les deux cas, c'est la méme boite de
dialogue qui permet de définir les propriétés qu'on
souhaite leur appliquer.

Les styles d'image qui peuvent étre appliqués aux
connecteurs sont Standard (le choix par défaut),
Linéaire, Directe ou Connecteur incurveé.

Dans la boite de dialogue :

- La rubrique Décalage de ligne permet de créer
un espacement entre des connecteurs qui se
chevauchent.

— La rubrique Interligne permet de définir pour
chaque extrémité du connecteur un écart
horizontal et vertical entre le connecteur et
l'objet.

Connecteur

B s
Type
Décalage de ligne
Interligne
Début horizontal
Début vertical
Fin horizontale
Fin verticale

Grouper des objets

Lorsqu'un dessin se compose de plusieurs objets,
il peut s'avérer utile de les grouper pour obtenir un
objet unique facile a sélectionner et a déplacer.

Pour réaliser un groupement :
1. Activez l'outil Sélection dans la barre d'outils

Dessin.

2. Sélectionnez l'ensemble des objets a grouper
(sélection "au lasso"), puis éventuellement

éliminez des objets superflus en cliquant
dessus avec la touche Shift enfoncée.

3. Lancez la commande Format > Groupe >
Grouper.

Une fois le groupe créé, un simple clic sur
n'importe quelle forme qui s'y trouve sélectionne
tout le groupe.

Pour éditer individuellement des éléments d'un
groupe sélectionné, appuyez sur F3 ou utilisez la
commande Format > Groupe > Entrer dans le
groupe : les éléments extérieurs au groupe sont
alors grisés et seules les formes appartenant au
groupe sont accessibles et peuvent étre éditées
individuellement. Pour quitter le mode groupe,
appuyez sur Ctrl+F3 ou utilisez la commande
Format > Groupe > Quitter le groupe: le
groupe apparait de nouveau sélectionné.

Pour dégrouper un groupe, sélectionnez-le, puis
utilisez la commande Format > Groupe >
Dissocier.

3.4. Les images bitmaps

Les images bitmaps sont constituées d'une
juxtaposition et d'une superposition de pixels,
c'est-a-dire de petits points qui peuvent prendre
différentes couleurs.

Caractéristiques

Nettement plus lourdes que leurs homologues
vectorielles, elles sont trés répandues, puisque
produites par les appareils photographiques
numeériques et les scanners.

Elles ont toujours des mesures bien définies et
toute modification de leur taille s‘accompagne
d'une perte de qualité.

OpenOffice dispose de quelques fonctionnalités
pour les modifier, mais elles sont limitées et il est
souvent nécessaire de faire appel a des logiciels
tiers spécialisés dans ce domaine, tels que GIMP,
Irfanview, XnView, etc.

Procédure d'insertion

Il existe différentes fagons d'insérer une image
bitmap dans une diapositive :

—La commande Edition > Coller permet une
insertion directe depuis le presse-papiers de
Windows.

© 2012 - 2013 G. Waterval Version : 26/04/13 Apache licence, Version 2.0

0004Kids - Apache OpenOffice~ - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

™

34/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

3.Insérer des objets

— La commande Insertion > Image ... insere une
image enregistrée localement sous forme de
fichier, ou de lien. Dans ce dernier cas, toute
modification du fichier source sera répercutée
sur la diapositive intégrant le lien.

— Si la diapositive destinataire contient un espace
réservé avec des icbnes cliquables pour
linsertion d'une image, tableau, vidéo,
diagramme, cliquez simplement sur celle
destinée a linsertion d'images pour accéder
directement a la boite d'insertion d'images.

— On peut également insérer une image depuis la
Gallery, en la faisant simplement glisser sur la
diapo affichée.

L'insertion d'une image fait apparaitre la barre
d'outils Image avec une série d'outils de retouche.

Barre d'outils Image

La barre d'outils Image apparait lorsqu'une image
bitmap est sélectionnée et permet de la modifier.
Cette barre en contient elle-méme deux autres : la
barre Filtre et la barre Couleur, toutes deux
déplacables dans l'espace de travail sous forme
de fenétres flottantes.

Image T X
« T Standard ¥ 3 Pow = L A8 B
1 2 3 4 56 7 8

Barre d'outils Image sous forme flottante

1. Filtre
Ouvre une palette de filtres applicables a l'image.

Filtre gra... = X
= oA Y
p  E
Z @ ®

— Invertir : inverse les couleurs d'une image en
couleurs ou les valeurs de luminosité d'une
image en niveaux de gris.

— Adoucir : adoucit le contraste.
— Augmenter la netteté : augmente le contraste.

— Supprimer les interférences : enléve des pixels
d'une image.

— Solarisation : imite les effets d'un excés de
lumiére dans un tableau. Une boite de dialogue
permet d'ajuster les paramétres.

— Vieillissement : simule le vieilissement d'une
photo. Peut étre appliqué a plusieurs reprises.
Une boite de dialogue permet de régler le
niveau de vieillissement souhaité.

— Poster : donne a une image l'aspect d'une
peinture en réduisant son nombre de couleurs.

— Pop‘art : maodifie I'image de fagon spectaculaire.

— Dessin au fusain : donne a l'image l'aspect d'un
dessin au fusain.

— Relief : une boite de dialogue permet d'agir sur
I'effet de relief en ajustant la source de lumiére
a l'origine de l'ombre.

— Mosaique : rassemble des groupes de pixels
dans une zone unique d'une seule couleur.

2. Mode Graphique

Les modes graphiques possibles peuvent étre
Par défaut, Niveaux de gris, Noir/Blanc, ou
Filigrane.

3. Couleur

Cette palette permet de modifier les couleurs de
base de limage (rouge, vert, bleu dans le
systeme RGB) ainsi que sa luminosité, son
contraste et son gamma. Si le résultat n'est pas
satisfaisant, vous pouvez utiliser le raccourci
Ctrl+Z pour restaurer les valeurs d'origine.

4. Transparence

Réglez le pourcentage de transparence dans le
champ compteur Transparence intégré a la barre
d'outils Image pour rendre [image plus
transparente. Ce réglage est particulierement
important lors de la création d'un filigrane ou
lorsqu'on souhaite positionner une image en
arriere-plan.

5. Ligne
Ouvre la boite de formatage des lignes.

6. Remplissage
Ouvre la boite de paramétrage d'un remplissage.

7. Ombre

Permet d'appliguer une ombre au contour de
l'image.
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3.Insérer des objets

8. Rogner l'image

Fait apparaitre des poignées spéciales sur les
c6tés et les sommets du pourtour de sélection de
I'image, pour permettre de la rogner directement a
I'aide de la souris.

Volet Propriétés (AOO 4.0)

Dans AOO 4.0 la barre latérale regroupe dans
son volet Propriétés la plupart des commandes
permettant d'intervenir sur une image bitmap
sélectionnée.

Properties
H Text
+ Paragraph
= Graphic
Brightness: Contrast:
':]:: l:]::
Color mode: Transparency:
= MNormal v | 0%
-J. 0% =y 0%
7 0% 1.00
= Line
Width: Color:
Style: Transparency:
- none - - [ 0%
Arrows;
- none - *| |- none- -
Corner style Cap style
Rounded w || [Flat -

4 Position and Size

Redimensionner et déplacer

Sélectionner l'image d'un clic gauche de souris
pour pouvoir la déplacer a la souris ou la
redimensionner en faisant glisser ses poignées
vertes de redimensionnement.

Un redimensionnement par les poignées d'angles
en maintenant la touche Shift enfoncée est
réalisé sans distorsions.

Faire tourner une image

Pour faire tourner une image manuellement,
procédez comme suit ;

1. Sélectionnez l'image en cliquant simplement
dessus : huit poignées vertes de
redimensionnement apparaissent sur son
contour.

2. Cliguez sur le bouton Rotation dans la barre
d'outils Dessin ou cliquez une seconde fois sur
limage. Huit poignées rouges circulaires
remplacent les poignées carrées vertes et un
axe de rotation déplagable apparait au milieu
de l'image.

3. Déplacez le pointeur de la souris sur l'une des
poignées d'angle jusqu'a ce qu'il prenne la
forme d'un arc de cercle avec une pointe de
fleche a chaque extrémité.

4. A ce moment, cliquez puis déplacez la souris

dans la direction souhaitée pour faire tourner

l'image. Une fois la rotation terminée, relachez
le bouton de la souris.

Pour restreindre les angles de rotation a des

multiples de 15 degrés, appuyez sur la touche Shift
pendant la rotation de I'image.

Rogner les images

Pour rogner une image a la souris, la sélectionner
puis cliquer sur l'icbne Rogner dans la barre
d'outils Image. Des marques de rognage
apparaissent autour de l'image.

En posant le curseur sur n'importe quelle marque
de rognage, celui-ci change de forme . Glissez

alors la marque pour rogner limage. Une fois
I'opération terminée, cliquez en dehors de l'image
pour désactiver le mode de rognage.
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3.Insérer des objets

3.5. Les images de la Gallery

L'insertion d'un objet de la Gallery dans la
diapositive courante peut se faire sous forme de
copie ou de lien.

— Copie : par un simple Cliquer glisser a l'aide de
la souris ou a l'aide de la commande Ajouter >
Copier dans le menu contextuel de l'objet a
insérer.

— Lien : par un Cliquer glisser a l'aide de la souris,
mais avec les touches Shift et Ctrl enfoncées,
ou a l'aide de la commande Ajouter > Lien
dans le menu contextuel de I'objet.

3.6. Ajouter des objets en
arriere-plan

On peut intégrer a l'arriere-plan des diapositives
toutes sortes d'éléments graphiques tels que
logos, lignes décoratives, etc.

Lorsqu'un élément graphique doit étre reproduit
sur toutes les diapos de la présentation, la
solution la plus simple consiste a lintégrer
directement dans la ou les pages maitresses de
la présentation en travaillant en mode Masque.
Par contre, s'il n'est destiné qu'a un nombre
restreint de diapositives, on peut directement
réaliser l'intégration sur les diapositives
concernées.

Pour ajouter un objet graphique en arriére-plan
d'une Page maitresse, procédez comme suit :

— Basculez en mode Masque par la commande
Affichage > Masque > Masque des diapos.

— Lancez la commande Insertion > Image > A
partir d'un fichier, puis choisissez limage a
utiliser dans la boite de dialogue d'insertion
d'images et décidez si son insertion doit se faire
par incorporation ou sous forme de lien.

Si vous souhaitez que l'image se méle a l'arriere-
plan, vous devez régler sa transparence dans ce
sens depuis la barre d'outils Image.

3.7. Créer une image animée

Y

Animer un objet consiste a modifier son
apparence de maniére continue, en le faisant
transiter par des étapes intermédiaires qui le
conduisent progressivement vers sa forme finale.

Chaque étape correspond a un objet
intermédiaire qui doit étre créé et occuper une
position précise dans la transition qui conduit a la
forme finale.

Créer les images des étapes

La création d'une animation nécessite donc, dans
un premier temps, la création d'autant de copies
de l'objet qu'il y aura d'étapes a parcourir pour le
faire passer de sa forme initiale a sa forme finale.

Ensuite, il faut retoucher la forme des différents
objets intermédiaires pour I'adapter aux différents
aspects que prendra l'objet au cours de sa
transition vers sa forme finale.

Une fois les différents objets intermédiaires
dessinés, lancez la commande Insertion > Image
animée... pour ouvrir la boite de dialogue

Animation et les intégrer dans 'animation a créer.

Créer la liste des étapes de
transition

Il faut d'abord définir la chronologie des étapes a
effectuer pour aboutir a I'animation finale. Deux
voies sont possibles pour atteindre cet objectif :

— Sélectionnez un a un les objets a intégrer, en
respectant l'ordre dans lequel ils doivent étre
placés, en cliquant a chaque fois sur le bouton
Appliquer I'objet.

—La seconde méthode suppose que Ila
succession des étapes composant l'animation
est correcte au départ : la premiére image est
en dessous, toutes les suivantes lui sont
superposées dans l'ordre de leur création. Dans
ce cas, vous pouvez sélectionner "au lasso"
I'ensemble des objets et les intégrer d'un seul
coup en cliquant sur le bouton Appliquer les
objets un par un.

Sous la fenétre de prévisualisation de la boite
Animation, on trouve une série de boutons qui
permettent d'afficher la premiére image de
I'animation, de reproduire I'animation, de la faire
fonctionner en marche arriere, de la stopper,
d'afficher I'une de ses images en choisissant son
numéro dans la liste Numéro de l'image.

(LOmDIpY [s =]

Vous pouvez également supprimer l'une des
images initialement prévue dans l'animation, en
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3.Insérer des objets

I'affichant dans la fenétre de prévisualisation, puis
en cliquant sur le bouton Supprimer l'image
active. Le bouton Supprimer toutes les images
vide compléetement la liste des images qui
figuraient dans le projet d'animation.

Finaliser et créer I'animation

Lorsque la construction de I'animation semble au
point, il reste a la créer, en cliquant sur le bouton
Créer, sous l'une des deux formes suivantes :
Objet de groupe ou Objet bitmap. Dans ce dernier
cas, il faut encore définir, dans 2 listes
déroulantes, sa durée d'affichage et le nombre de
répétitions souhaité (nombre de cycles).

C'est seulement a ce moment qu'on peut
supprimer les objets dessinés, car ils sont
maintenant intégrés comme images
intermédiaires.

Par mesure de sécurité, vous pouvez effectuer
d'abord une copie de la diapositive qui les contient.

Une fois l'animation créée, vous pouvez la
sélectionner et la déplacer comme tout autre objet
a l'endroit de votre choix et méme lui associer un
effet d'entrée.

Une animation se supprime comme un objet normal,
il suffit de la sélectionner puis de taper Delete au
clavier.

Exporter au format GIF

Vous pouvez exporter votre animation au format
GIF.

1. Sélectionnez I'objet animé.

2. Lancez la commande Fichier > Exporter ....

3. Sélectionnez GIF - Graphics Interchange
Format (.gif) dans la liste Format de fichier.

4. Cochez la case Sélection pour exporter I'objet
sélectionné et non la diapo entiére.

5. Choisissez un emplacement et un nom pour le
fichier GIF animé.

6. Cliquez sur Enregistrer.

3.8. Les boutons d'action

Les objets insérés aux diapositives peuvent étre
utilisés comme boutons de démarrage pour
différentes actions.

Pour définir de telles interactions :

— Commencer par sélectionner l'objet support,
puis définir l'interaction a lui associer dans la
boite de dialogue Interaction. Cette boite
s'ouvre depuis le menu contextuel de I'objet ou
par la commande Diaporama > Interaction...

— Dans la boite qui s’ouvre, choisir dans la liste
déroulante l'une des interactions proposées,
puis validez par OK.

Lorsqu'une diapositive intégrant des boutons
d'action est affichée en mode Normal, si vous
pointez sur ces boutons, votre marqueur souris
prend la forme d'une main et une infobulle vous
indique I'action associée.

Pour annuler momentanément l'interaction en mode
Normal, afin de pouvoir sélectionner I'objet, il suffit
de cliquer dessus en maintenant la touche Alt
enfoncée.

3.9. Les champs

Il est possible d'insérer des instructions de champ
(date, heure, auteur, numéro de page ou nom de
fichier) dans une diapositive en mode d'affichage
Normal.

Pour cela, lancez simplement la commande
Insertion > Champs puis sélectionnez
l'information a insérer dans la liste déroulante.
Lors de la validation de la commande, une zone
de texte contenant linstruction choisie apparait
dans la diapositive et il ne reste plus qua la
positionner finement a l'aide de la souris.

Pour modifier le format du contenu d'un champ, le
sélectionner, puis appeler son menu contextuel et
choisir la commande appropriée.

3.10. Les hyperliens

Les textes correspondant a des adresses web ou
adresses Email sont automatiquement formatés
par Impress en liens hypertexte, avec la couleur
de texte et le soulignement définis dans les
options générales du programme, sous l'onglet
Apparence. Si vous ne souhaitez pas conserver
ce formatage, sélectionnez la commande Edition
> Annuler ou utlisez le raccourci Ctrl+Z
immédiatement aprés que le formatage a été

appliqué.

Pour renoncer a l'application d'un tel formatage,
allez sous Outils > Options d'AutoCorrection >
Options et décochez Détecter les URL.
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3.Insérer des objets

Insérer un hyperlien

Pour insérer un hyperlien ou pour personnaliser
son apparence, utilisez la commande Insertion >
Hyperlien pour ouvrir la boite Hyperlien.

Editer des textes hyperliens

Pour éditer le texte d'un hyperlien, sélectionnez
le, puis lancez la commande Edition > Hyperlien
et procédez aux modifications souhaitées avant
de les valider en cliquant sur le bouton Appliquer.

La boite reste ouverte pour vous permettre d'éditer
d'autres hyperliens. Lorsque vous avez terminé,
cliquez sur Fermer.

Utiliser des boutons hyperliens

Un bouton hyperlien s'insére au centre de la diapo
active affichée en mode Normal lorsqu'on choisit
l'option Bouton dans la liste déroulante
Formulaire de la boite de dialogue Hyperlien.

Pour modifier la taille d'un bouton, le déplacer ou
encore éditer son texte. Pour cela, commencez
par afficher la barre d'outils Contréles de
formulaire et cliquez sur l'icbne (Dés)activer le
mode ébauche.

Vous pouvez alors cliquer sur le bouton et le
déplacer a un autre endroit, ou effectuer un clic
droit dessus pour accéder a sa boite de
propriétés et pouvoir modifier son étiquette et son
formatage.

Une fois I'édition du bouton terminée, cliquez une

nouvelle fois sur licbne (Dés)activer le mode
ébauche pour l'activer.

3.11. Les tableaux

Les tableaux sont pris en charge nativement dans
Impress, mais avec toutefois moins de
fonctionnalités que dans Calc ou Writer.

L'insertion d'un tableau dans une diapositive peut
se faire de différentes maniéres :

1. Bouton Tableau dans la barre d'outils Tableau
ou la barre d'outils Standard.

2. Commande de menu Tableau > Insérer
>Tableau.

3. Commande de menu Insertion > Tableau ...

4. Simple clic sur licobne permettant l'insertion
d'un tableau dans un espace réservé. La boite
Insérer un tableau s'ouvre pour permettre la
définition des dimensions du tableau.

5. Onglet Ebauche de tableau dans le volet
Téches. Il suffit de cliquer sur le style de
tableau désiré pour voir apparaitre la boite
Insérer un tableau et pouvoir indiquer les
dimensions du tableau.

Le tableau apparait dans la diapositive comme un
objet graphique, accompagné de l'affichage de
deux barres contextuelles, Tableau et Formatage
de texte permettant de le formater.

Les tableaux Impress se manipulent comme
n'importe quel autre objet graphique ; on peut
modifier leur position sur la diapo et les
redimensionner en utilisant la souris.

Le modéle choisi dispose d'options qu'on peut
activer ou désactiver dans la rubrique Afficher.

— Ligne de titre : option par défaut qui permet
d'appliquer a la premiere ligne du tableau un
arriere-plan différent.

- Ligne de total : applique a la derniere ligne du
tableau un arriere-plan différent pour la
distinguer des autres lignes.

— Lignes colorées : option active par défaut qui
permet d'alterner les lignes avec différents
arriere-plans pour faciliter la présentation des
données en lignes.

— Premiére colonne : met en relief la premiére
colonne du tableau en Ilui appliguant une
couleur d'arriére-plan plus foncée.

— Derniére colonne : met en relief la derniere
colonne du tableau en Ilui appliguant une
couleur d'arriére-plan plus foncée.

— Colonnes colorées: permet d'alterner les
colonnes avec différents arriére-plans pour
mieux faire ressortir les données.

Les fonctions Tri et Somme ne sont pas disponibles
dans un tableau Impress. Pour obtenir de telles
fonctionnalités dans Impress, il faut insérer une
feuille de calcul depuis Calc, comme objet OLE.

3.12. Les objets multimédias

Vous pouvez insérer du contenu multimédia dans
une diapositive en cliquant, a lintérieur d'un
espace réservé, sur l'icobne Insérer une vidéo.
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3.Insérer des objets

Vous pouvez également utiliser la commande de
menu Insertion > Vidéo et son ...

Dans les deux cas, la boite de dialogue
Sélectionnez un fichier s'ouvre pour vous
permettre de choisir sur votre disque le fichier a
insérer.

La boite renferme une option permettant également
I'insertion d'un fichier multimédia sous forme de
lien.

Une fois votre fichier chargé, I'image ci-dessous le
représente dans la diapositive. Vous pouvez
modifier son ancrage, sa taille et son alignement
comme vous le feriez avec une image normale.

Pour exécuter le fichier multimédia, cliquez sur
I'image qui le représente pour afficher le lecteur
multimédia représenté ci-dessous et pouvoir le
lire.

Lecteur de médias X

“@a@8t— memwde ) o

Pour qu'un fichier multimédia soit lu en projection
automatiguement lors de I'apparition de la
diapositive qui le contient, son exécution doit étre
définie dans la transition attachée a la diapositive.

3.13. Les objets OLE

On peut insérer dans la diapositive courante un
classeur Calc par la commande Insertion > Objet
> Objet OLE ... qui ouvre la boite ci-dessous.

Insérer un objet OLE

@ Creer un nouvel objet © Créer a partir d'un fichier

Type d'objet

Classeur OpenOffice.org 3.4.1
Diagramme OpenOffice.org 3.4.1
Dessin OpenOffice.org 3.4.1

Formule OpenOffice.org 3.4.1 %
Texte OpenOffice.org 3.4.1

Autres objets

Choisir entre créer un nouveau classeur ou
importer un classeur existant. A la validation, une
feuille de calcul apparait dans la diapositive, et les
menus et barres d'outils d'/mpress sont remplacés
par ceux de Calc pour permettre de travailler dans
la feuille de calcul affichée.

Insérer un objet OLE dans une diapositive consiste a
intégrer dans celle-ci un objet provenant d'une
application externe, comme une image en
provenance d'un logiciel de manipulation d'images,
un document texte en provenance d'un traitement
de texte, une feuille de calcul provenant d'un
tableur, etc. L'objet OLE s'ouvre avec le programme
qui I'a généré, ce qui permet de le modifier.

3.14. Animer les objets insérés

De la méme maniére qu'il est possible d'associer
un effet lors de l'apparition des diapositives en
projection, il est également possible d'en associer
a leurs contenus.

On peut ainsi, une fois la diapositive affichée,
faire apparaitre ses contenus les uns apres les
autres, dans un ordre donné et de maniére
dynamique, grace aux effets d'animation qui leur
sont associés.

Les animations d'objets dans une diapositive sont
souvent utilisées pour présenter un schéma
complexe en dévoilant ses différentes parties
progressivement. Cela évite un affichage de départ
trop surchargé.

Les effets prédéfinis peuvent étre classés en 3
catégories :

— Les effets d'apparition/disparition, du méme
genre que ceux rencontrés dans les effets de
transition, mais cette fois appliqués aux objets
intégres.

- Les animations de textes comme les
défilements de textes ou les textes apparaissant
caractere par caractere.

— Des séquences d'apparition d'objets : les
objets apparaissent les uns aprés les autres,
dans un ordre défini et accompagnés d'un effet.

Lorsqu'une animation est associée a un objet, il est
toujours possible de la modifier ultérieurement et
méme de la supprimer.
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3.Insérer des objets

Ajouter une animation a un
objet
Chaque objet inséré dans une diapositive peut

étre animé au moment de son apparition, lorsqu'il
doit disparaitre, au passage de la souris, etc.

Les effets d'animation se définissent depuis
l'onglet Animation personnalisée dans le volet
Taches, en mode d'affichage Normal.

Dans AOO 4.0, les animations se définissent
depuis le volet Animation dans la barre latérale.

Animation personnalisée

| Effets divers |

Entrée | Accentuation || Quikker || Trajectoires
Basique s
A

Artivée

Artivée lente
Balayer

Boite

Cercle

Cain

Damier

Dissalution interne
Effets aléataires
Flash

Insertion Furtive
Lignes aléatoires
Losange

Flus

Quadrillage en diagonale
Roue

Crirdar

Witesse |M0yen

Apercu automatique

[

[ QK ][ Annuler ][ Aide ]

Procédez comme suit :

1. Sélectionnez l'objet & animer, puis activez le
volet Animation personnalisée.
2. Cliquez sur le bouton Ajouter... pour ouvrir la
boite de dialogue Animation personnalisée.
Cette boite renferme sous 5 onglets les
différentes catégories d'effets disponibles
Entrée, Accentuation, Quitter (effets de
fermeture) Trajectoires et Effets divers.
—Entrée : effets accompagnant I'apparition
d'un objet, invisible au départ, sur la
diapositive.

— Accentuation : option permettant d'augmenter
la visibilité d'un effet appliqué a un objet.

— Quitter . effets accompagnant la sortie
d'objets de la diapositive.

— Trajectoires : effets définissant les trajectoires
de déplacement de I'objet sur la diapositive.

— Effets  divers: destinés aux fichiers
multimédias pour gérer leur lecture et leur
arrét.

3. Pour appliquer un effet, le sélectionner dans
I'une des catégories disponibles dans la boite.

Si vous avez sélectionné un objet de dessin, comme
un rectangle contenant du texte, vous pouvez
assigner un effet différent au texte et a I'objet.

Lorsque l'option Apercu automatique est cochée,
un apercu de l'animation choisie s'exécute pour
vous aider & tester vos choix avant de les valider.

Une liste déroulante Vitesse permet de choisir,
pour certaines animations, une vitesse
d'exécution (lent, moyen, rapide, trés rapide).

Paramétrer une animation

En plus du bouton Ajouter ... qui réalise
I'association d'un effet d'animation a un objet dans
une diapositive, le volet Animation personnalisée
renferme toute une série d'options qui permettent
de paramétrer et de modifier I'effet a tout moment.

< Animation personnalisée
Modifier I'effet

Ljouter, .,

Effet Balayer

Dernarrer |ﬂu clic V|
Oriertation |['J~ partir du bas V| u
Witesse |Tré5 rapide w |

Sily =& Texte (titre) 'Cbjectifs' 1: Ohb...

Modifier l'ordre © @

[ Lire H Diaporama ]

Apercy automatique
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3.Insérer des objets

Les effets d'animation définis sont répertoriés
dans une liste. Pour modifier l'un d'eux, le
sélectionner puis réaliser les modifications
souhaitées.

Dans la liste des animations existantes, les objets
animés sont précédés de deux icOnes
renseignant sur le genre d'animation qui leur est
associée.

— La premiére icone indique comment l'effet va
démarrer (ici au clic de la souris).

—La seconde icbne indique le type d'effet
appliqué (ici un effet d'entrée).

Les boutons de commandes

—Le bouton Ajouter comme VU
précédemment, ce bouton permet d'associer un
effet d'animation a un objet sélectionné dans la
diapositive courante.

— Le bouton Modifier ... ouvre a nouveau la boite
Animation  personnalisée, pour  pouvoir
remplacer l'effet d'animation sélectionné par un
autre.

— Le bouton Supprimer annule directement toute
animation sélectionnée dans la liste.

—Le bouton Lire exécute toute animation
sélectionnée dans la liste des animations.

—Un clic sur le bouton Diaporama lance le
diaporama.

Les options de configuration

L'effet sélectionné peut étre configuré a l'aide des
options suivantes, également présentes dans le
menu contextuel des objets animés.

Démarrer : permet de choisir dans une liste
I'événement qui déclenchera l'animation.

Orientation : définit la direction de I'effet.

Bouton Options d'effet L ouvre une boite & 3
onglets permettant d'associer un son a I'exécution
d'un effet, mais également de régler l'apparition
ou la disparition de I'objet.

— Effet . renferme des options permettant de
rendre l'objet invisible aprés l'application de
l'effet, ou encore de le masquer ou de
I'estomper. On peut également décider d'animer
le texte en bloc, mot par mot ou lettre par lettre.

— Minutage : réglage du minutage

— Vitesse
d'exécution.

permet de choisir une vitesse

Modifier I'ordre ces deux boutons fléchés
permettent de modifier l'ordre d'exécution des
effets (par défaut c'est leur ordre de création).
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Nous aborderons dans ce chapitre les travaux de
finition a réaliser sur une présentation avant de
passer au paramétrage de sa projection.

4.1. Réorganiser les vues

Le mode Trieuse de diapositives est le plus
adapté pour réorganiser l'ordre de succession des
pages d'une présentation car il les affiche en
réduction comme si elles se trouvaient étalées sur
une table lumineuse.

Le déplacement de diapositives peut également étre
réalisé, mais de maniere moins pratique, depuis le
volet Diapositives dans les modes d'affichage Plan,
Normal et Notes ou encore depuis le Navigateur.

Vous pouvez modifier le nombre de diapositives
affichées dans ce mode en l'indiquant dans la liste
déroulante de la barre d'outils Mode Diapo.

@ | @ M [70apos 7

Pour déplacer une diapositive, la faire
simplement glisser a l'aide de la souris jusqu'a sa
position finale. Au cours du déplacement, la diapo

apparait en réduction pour faciliter le repérage de
I'endroit ou elle doit s'insérer.

Proposition de stratégie La situation actuelle

i caracténise la situation ac-

L'évolution Eventuelles alternatives

= qui ne ss sont pas réalisées
= qui s& sont bien réalisées

La numérotation des diapos s'adapte
automatiquement a l'issue de toute réorganisation
et les effets de transition ne sont pas affectés.

Pour déplacer plusieurs diapositives, maintenir
la touche Ctrl enfoncée, puis sélectionner
successivement les diapositives a déplacer.
Relacher la touche Ctrl une fois la sélection
réalisée, puis cliquer sur la sélection et, tout en
maintenant le bouton de la souris enfoncé, la faire
glisser vers sa position finale.

En effectuant le déplacement d'une sélection en
maintenant la touche Ctrl enfoncée, on réalise une
copie et non un déplacement, comme le montre le
pointeur de la souris qui prend la forme du signe +.

4.2. Masquer des diapositives

En mode Trieuse de diapositives, le menu
contextuel d'une diapositive propose la
commande bascule Masquer/Afficher la
diapositive, qui permet de masquer certaines
diapositives, sans pour autant les supprimer de la
présentation.

Le masquage de diapositives permet de réaliser
des présentations personnalisées a partir d'une
méme présentation de base. Lorsque des vues
sont masquées, elles sont hachurées.

L'évolution Eventuelles dlfernatives

sont pas réalisées
ien realisees
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4. Finaliser une présentation

Diapo 5 affichée et diapo 6 masquée

* Masquer une diapo ne la supprime pas de la
présentation. Pour supprimer une diapo, la
sélectionner puis appuyer sur Delete.

+ Le masquage de diapositives peut également
s'effectuer depuis le volet Diapositives dans les
modes d'affichage Plan, Normal et Notes.

4.3. Créer un sommaire

La diapositive de résumé est le moyen le plus
adapté pour créer un sommaire reprenant toutes
les grandes étapes d'une présentation.

En principe, on recommande d'effectuer cette
opération en mode Trieuse de diapositives, mais
on peut également la réaliser depuis le volet
Diapos des modes Plan, Normal et Notes.

2. Affichez le volet Transition dans le volet
Taches, ou dans la barre latérale si vous
utilisez AOO 4.0, puis cochez l'option Apercu
automatique tout en bas du volet, afin d'obtenir
une prévisualisation des effets de transition
choisis avant leur application et pouvoir plus
facilement apprécier ceux qui conviennent le
mieux.

3. Choisissez l'effet souhaité dans la rubrique
Appliquer aux diapos sélectionnées.

L'effet Aucune transition signifie que vous ne
souhaitez pas appliquer d'effet de transition a la ou
aux diapositive(s) sélectionnée(s) ou que vous
désirez supprimer celui qui leur a été appliqué
antérieurement.

Modifier une transition

Une diapositive de résumé hérite automatiquement
du design des diapositives de la présentation.

Procédez comme suit ;

1. Sélectionnez les diapositives a faire figurer
dans le sommaire, en utilisant la touche Ctrl
pour sélectionner des diapositives non
successives ou la touche Shift pour réaliser la
sélection de séries de diapositives contigués.

2. Lancez la création de la diapositive
"Sommaire” par la commande Insertion >
Diapo de résumé. La diapositive de résumé
est créée et se place, par défaut, en fin de
présentation.

3. Déplacez la diapositive de résumé a l'endroit
souhaité dans la présentation.

4.4. Effets de transition

Les transitions sont des effets qui accompagnent
le passage d'une diapositive a l'autre lors de la
projection. La définition de tels effets peut se faire
en mode Trieuse de diapositives, ou encore
depuis le volet Diapos des modes daffichage
Plan, Normal et Notes.

Les vignettes des diapos auxquelles un effet de
transition est associé sont signalées par la

présence de l'icone *#*

Définir un effet de transition

1. En mode d'affichage Trieuse de diapositives,
sélectionnez les diapositives auxquelles vous
souhaitez appliquer un effet.

< Transition

Appliquer aux diapos sélectionnées

Aucune transition

Balayage en haut

Balayage A droite

Ealayage 4 gauche

Balayvage en bas

Roue dans le sens des aiguilles d'une montre
Roue dans le sens des aiguilles d'une montre
Fove dans le sens des aiguilles d'une montre B

(==

M i Ao e cmimie A —im illme AN e e

< Lif I >
Modifier la transition

Witesse |Rapide v|
Sor |<Aucun son V|

En boucle jusqu'au son suivant

Passer a la diapo suivante
O au dlic

i Autornatiguement aprés

[ Appliquer & toutes les diapos ]

[ ure ][ Diaporama |

Apercu automatique

La rubrigue Modifier la transition permet de
paramétrer la vitesse d'exécution de la transition
(lente, moyenne ou rapide) et de lui associer un
son.

Passer a la diapo suivante

Cette rubrique permet de définir une modalité de
passage a la diapositive suivante :

— Au clic : vous devez cliquer pour passer a la
diapo suivante.
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4.Finaliser une présentation

— Automatiquement aprés : spécifiez le temps de
pause souhaité sur la diapositive avant passage
automatique a la diapo suivante.

Au bas de longlet Transition, 3 boutons
permettent, d'appliquer I'effet choisi a I'ensemble
des vues de la présentation, de le visualiser
(bouton Lire) ou de démarrer la projection du
diaporama avec les effets de transitions définis
(bouton Diaporama).

4.5. Ajouter des notes

Le mode d'affichage Notes permet d'associer des
commentaires aux diapositives au moment méme
de leur production, ou a posteriori.

Ces informations ne sont visibles que du
présentateur lors de la projection, mais elles sont
reproduites sur les sorties papier distribuées au
public.

Dans le mode d'affichage Notes, le cadre inférieur
de la page correspond a la zone dans laquelle le
commentaire peut étre saisi.

Ce mode de travail offre toutes les fonctionnalités
d'édition et de formatage de texte dans une barre
d'outils Formatage du texte qui apparait automati-
quement lorsqu'on clique sur du texte se trouvant
dans la zone d'édition.

Formatage du texte T X

|aial vz ¥
6 /S @E=m
w2 T LRI A RE &-

Si vous utilisez AOO 4.0, le volet Propriétés de la
barre latérale regroupe en différents panneaux les
principales commandes qui vous permettent de
mettre en forme directement le texte de vos
notes.

N'oubliez toutefois pas que le texte de vos notes
est formaté par défaut par le style de présentation
Notes et que c'est ce style que vous devriez
modifier en priorité si vous voulez changer la mise
en forme générale des notes dans votre
présentation.

Properties

= Text

Thorndale |« | 24 |w [_f' ;5'.
B /7 U~ A -
&R N
=I Paragraph
Spacing: Indent:
000" 0.00"
000" 0.00"

- 0.00"

Ci-dessous, une copie d‘écran du volet
Propriétés, lorsque votre point d'insertion se
trouve dans la zone d'édition de texte en mode
Notes.

Le mode Notes vous permet également de réaliser
des dessins sur l'image méme de la diapo dans la
partie supérieure de la page, sans toutefois que
ceux-Ci ne soient visibles lors de la projection. Il est
également possible de dessiner dans la zone
d'édition de texte.

4.6. Modifier I'arriere-plan

L'arriere-plan d'une présentation (au sens d'image
ou de couleur de fond des diapositives) n'a pas
pour unique but de rendre une présentation
attrayante, il en améliore également la lisibilité. Il
s'agit donc d'un paramétre qu'on peut avoir a
modifier rapidement en fonction des conditions
d'éclairage de la salle dans laquelle s'effectue la
projection.

En mode daffichage Normal uniquement, la
commande Format > Page ... > Arriére-plan
ouvre une boite permettant de choisir une couleur
de fond, un dégradé, un motif ou une image a
appliqguer comme arriére-plan.

Apres validation de la commande par OK, la boite
ci-dessous apparait.
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4. Finaliser une présentation

Le style de présentation Objets d'arriere-plan
permet d'agir sur le formatage du texte contenu
dans ces substituants.

Paramétres de la page |X

@ Paramétres d'artigre-plan pour toutes les pages ?

L OL“ J [ Mo l En-téle et pied de page |§‘

Diapo | Notes st prospectus |
. . N Incure dare la dia 5
— Si vous cliquez sur le bouton OUI, votre arriere- Pe st 1 ke puiat N
plan sera appliqué a la diapositive courante et a O | |
toutes celles qui partagent le méme masque L ke B
gu'elle.
. . . . [lpied do pacs 2
- Si vous cliquez sur NON, seule la diapositive Sy |
active verra son arriere-plan modifié.
[ uméro de diapn 3 7
+ Une autre méthode pour changer I'arriere-plan de [T pas afficher sur I premie daps 4
la diapositive active consiste a tracer dessus un i i
objet rectangle puis a lui appliquer la couleur de

fond ou le dégradé souhaité a l'aide de la
commande Format > Remplissage.... Il reste
alors a le positionner en arriere-plan de tous les
autres objets de la page par la commande
contextuelle Organiser > Envoyer a l'arriéere.
Pour appliquer la modification aux autres diapos
liées au méme masque, il faut réaliser I'opération
directement sur le masque, en mode Masque, et
non sur la diapo.

« Pour insérer une image (logo p.ex) en arriere-plan
de toutes les pages, travaillez sur la diapositive
de masque et utilisez la commande Insertion >
Image > A partir d'un fichier.... Placer ensuite
I'image en arriére-plan.

. Date et heure: insére dans le substituant en

bas a gauche, soit la date du jour,
automatiquement actualisée a l'ouverture du
fichier, soit la date fixe que vous indiquez.
Vous devez spécifier la langue pour le format
de date et heure. Si la rubrique est décochée,
les informations correspondantes ne sont pas
affichées, mais pas pour autant supprimées du
masque.

. Pied de page : insére le texte de votre choix

(souvent le nom de l'auteur de la présentation)

« Pour modifier l'arriere plan d'un masque et
étendre la modification a toutes les diapositives
qui lui sont liées, il suffit de modifier le style de
présentation Arriére-plan depuis le Styliste.

dans le substituant "Pied de page" du masque.
Si la rubrique est décochée, les infos
contenues en "Pied de page" ne sont pas
affichées mais pas pour autant supprimées du
masque, si elles existaient.

3. Numéro de diapositive : affiche, en bas a
droite, le numéro de la diapositive. Si l'option
est décochée, le numéro ne s'affiche pas. Vous
pouvez changer de format de numérotation
des pages dans l'onglet Page de la boite
ouverte par la commande Format > Page...

4. Ne pas afficher sur la premiére diapo : permet
de ne pas insérer d'infos sur la diapositive de
titre de la présentation, si on décide
d'appliguer la commande a toutes les
diapositives de la présentation.

5. Bouton Appliquer partout : applique les infos
a toutes les diapos de la présentation qui sont
liées au méme masque.

6. Bouton Appliquer : applique les parametres
actifs a la diapositive active uniqguement.

La boite ci-dessous s'affiche également a I'appel des 7. Zone de prévisualisation : prévisualise vos

commandes Insertion > Numéro de page ou choix et vous indique les substituants présents

Insertion > Date et heure. . . .

sur le masque de diapo, ainsi que leur position

4.7. En-tétes et pieds de page

En affichage Normal, la commande Affichage >
En téte et pied de page ... ouvre une boite dont
l'onglet Diapo permet d'insérer, au bas des
diapositives, dans 3 zones de texte existantes
appelées substituants, les 3 informations
suivantes : Date et heure, Pied de page, et
Numéro de diapo.

La zone intitulée Pied de page renferme
généralement le nom de l'auteur, avec le titre et la
date de I'exposé.

Le contenu saisi dans ces zones peut s'afficher
uniguement dans la diapositive courante, ou
étendu a toutes les diapositives de la présentation
basées sur le méme masque.

© 2012 - 2013 G. Waterval Version : 26/04/13

Apache licence, Version 2.0
0004Kids - Apache OpenOffice~ - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

™

46/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

4.Finaliser une présentation

et I'état de leur contenu : visible (encadrement
noir) ou masqué (encadrement grisé). Vous
pouvez parfaitement basculer en mode
Masque pour redimensionner ou déplacer ces
zones a votre convenance.

L'onglet Notes et prospectus permet de spécifier les
infos a reprendre en haut et en bas du masque des
notes et du masque du prospectus. Il fonctionne sur
le méme principe que l'onglet Diapo. Remarquez
que le masque des notes posséde un substituant
"En-téte" qui n'existe pas sur un masque de
diapositive.

4.8. Les masques

Un masque de diapositive ou Page maitresse est
une diapositive spéciale qui sert de support aux
propriétés et objets graphiques transmis a toutes
les diapositives qui lui sont liées. : styles de texte,
images et dessins d'arriere-plan, jeu de couleurs
etc. On y trouve également 5 zones d'informations
spéciales (titre, objet, date, pied de page et
numeéro) qu'on peut décider d'afficher ou de
masquer, mais qu'on ne peut pas supprimer. Le
masque agit donc comme un modéle de page
déterminant la mise en forme de toutes les
diapositives qui lui sont liées.

Plusieurs termes sont utilisés pour désigner ce
concept : Page maitresse, Style de diapo, Modéle
d'arriere-plan, Masque de diapositive ou encore
Modeéle de conception (PowerPoint).

Liste des Pages maitresses

Les pages maitresses sont répertoriées dans le
volet Pages maitresses ou elles se répartissent
en 3 catégories (panneaux).

— Utilisées dans cette présentation regroupe les
pages maitresses utilisées dans la présentation
active. Celles-ci ne correspondent pas toujours
a des pages maitresses enregistrées dans le
programme. Il peut s'agir de masques créés
uniguement pour la présentation en cours et qui
ne seront enregistrés qu'avec elle et donc pas

accessibles directement  pour  d'autres
présentations.
— Récemment utilisées affiche les  derniéres

pages maitresses qui ont été utilisées dans
d'autres présentations.

— Disponibles pour I'utilisation répertorie celles qui
peuvent étre liées a des diapositives de la

présentation active. Si vous avez créé votre
propre modéle, ou ajouté des modeéles externes,
leurs pages maitresses apparaitront dans cette
liste.

Utiliser plusieurs pages
maitresses

Une présentation peut utiliser plusieurs Pages
maitresses, chacune d'elles étant alors associée
a un groupe de diapositives.

Cette facon de faire permet de rompre la
monotonie d'un diaporama, de mieux le structurer,
et d'améliorer sa lisibilité, par exemple lorsque
deux sujets sont traités en paralléle.

On peut ainsi avoir, par exemple un masque
différent pour la page d'accueil générale (sans pied
de page), les tétes de chapitres et les diapositives
standards.

Pour modifier I'arriére-plan et d'autres
caractéristiques de toutes les diapos de la
présentation, il suffira donc de modifier sa ou ses
pages maitresses ou d'en choisir d'autres.

Editer un masque

Pour accéder au masque de la diapositive active,
utiisez la commande Affichage > Masque >
Masque des diapos. Vous basculez alors dans
un mode d'affichage particulier qui vous fournit,
dans I'espace de travail, le masque associé a la
diapositive active et vous permet de le modifier.

La barre d'outils Masque

Ce mode de travail fait également apparaitre la
barre d'outils Mode Masque.

Mode Masque ~
21 ¥1 £ | Fermer le mode Masque
1 2 3 4

1. Nouveau masque: crée un nouveau masque

2. Supprimer le masque : supprime un masque

sélectionné

Renommer le masque : renomme un masque

4. Fermer le Mode Masque : permet quitter le
mode Masque et de revenir au mode Normal.

w

Modifier les diapositives ou leur masque ?
Tout dépend de ce que vous voulez faire :

— S'il s'agit de modifier ponctuellement quelques
diapositives pour les mettre en évidence, les
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4. Finaliser une présentation

modifications peuvent étre réalisées
directement, en mode Normal, sur les
diapositives concernées. Ces modifications
directes prennent alors le pas sur les mises en
formes correspondantes héritées du masque
appliqgué. Mais cette méthode doit rester
occasionnelle, il ne faut pas en abuser sous
peine de nuire a I'homogénéité du design de la
présentation.

- S'il s'agit de réaliser des maodifications globales,
a répercuter sur I'ensemble des diapositives, ou
sur une partie de celles-ci, il faut alors basculer
en mode de travail masque, par la commande
Affichage > Masque, pour pouvoir modifier le
ou les masques concernés, y rajouter
éventuellement des éléments graphiques (logo)
et répercuter ces modifications directement sur
toutes les diapositives utilisant le ou les
masqgues modifiés. C'est la bonne fagon de
procéder dans la grande majorité des cas.

Les types de masques

Deux types de masques sont disponibles, tous
deux hérités de la ou des Page(s) maitresse(s)
utilisée(s) dans la présentation :

— Masque des diapos : responsable du design
général des diapositives qui l'utilisent.

— Masque des notes : responsable du design des
pages en mode Notes et Prospectus.

Une Page maitresse transmet donc ses
propriétés graphiques aux diapos qui lui sont liées
par l'intermédiaire de ces deux masques : l'un
pour les diapos en mode Normal, I'autre pour la
mise en forme des pages en mode Notes ou
Prospectus.

Ces deux masques peuvent étre modifiés par
I'utilisateur s'il veut changer certaines des options
graphigues transmises par la ou les pages
maitresses aux diapositives de sa présentation.

Masque des diapos

Les propriétés de tous les éléments du masque
sont enregistrées dans les styles de la catégorie
Styles de présentation dans le Styliste. Ces styles
sont modifiables et leurs modifications sont
répercutées a toutes les diapos utilisant le
masque modifié.

Cliquez pour &diter le format du
1 texte-titre
+ Cliguez pour &diter le format du plan de texte
+ Second nhveau de plan
- Troisigrme nhveau de alan
= Duatrérna rvaau de plan
2 T e nhcaan g
+ Seplérne riveau dz plan

« Butérma nisrau da plan
+ Meuvigma niwaau da plan

ke 4 Tl R Tage 5 T

3

1. Zone de titre. Le formatage qui lui sera
appliqué sera transmis a tous les titres des
diapositives partageant le méme masque.

2. Différents niveaux de plan disponibles pour le
texte saisi dans les espaces réservés de texte
(et donc visible en mode Plan). On peut les
formater en modifiant le style qui leur est
associé dans la catégorie Styles de
présentation dans le Styliste. On peut
également modifier les puces pour chaque
niveau de plan.

3. Substituant destiné a l'insertion de la date et
de I'heure qui apparaitra dans l'onglet Diapo
de la boite En-téte et pied de page.

4. Substituant "Pied de page" pour l'insertion d'un
texte libre (nom d'auteur, par exemple) qui
apparaitra dans l'onglet Diapo de la boite En-
téte et pied de page .

5. Substituant pour linsertion du numéro de la
diapositive qui apparaitra dans l'onglet Diapo
de la boite En-téte et pied de page.

La présence dans le masque des substituants (3),

(4) et (5) est contrblée par la commande

Affichage > Masque > Eléments du masque ...

qui ouvre la boite Eléments du masque

permettant de cocher ou de décocher la présence
de ces zones dans le masque.

Eléments du masque ig

Substituants
En-téte
Date/heurs
Pied de page
huméro de diapo

[ QK ] [ Annuler

© 2012 - 2013 G. Waterval

Version : 26/04/13

0004Kids - Apache OpenOffice

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

Apache licence, Version 2.0
- OOoLight

™

48/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr

4.Finaliser une présentation

Ces espaces peuvent étre redimensionnés et
déplacés directement sur le masque a l'aide de la
souris. Notez au passage que les masques de
diapos ne contiennent pas de zone d'en-téte.

Lorsqu'on modifie le formatage de textes au niveau
d'une diapositive de masque, les modifications ne
seront pas répercutées sur les textes des
diapositives dont le formatage a été modifié
manuellement avant que le masque ne soit modifié.
Une raison de plus pour n'appliquer des formatages
directs sur une diapo que dans des situations
exceptionnelles.

Masque des notes

Il fonctionne de maniére analogue au masque de
diapo mais posséde un substituant "En-téte"
supplémentaire.

Dans la partie inférieure de la page, le format des
notes est associé au style Notes dans la catégorie
Styles de présentation du Styliste.

Les informations destinées aux substituants sont
insérées depuis l'onglet Notes et prospectus de la
boite En-téte et pied de page.

Changer de masque

Identifier le masque associé a une

diapositive

Iy a 2 facons d'identifier le masque utilisé (et

donc la Page maitresse a laquelle une diapositive

est liée) :

1. Cliquer sur le bouton Conception de diapo
dans la barre d'outils Présentation. La boite de
dialogue Style de diapo s'ouvre et montre le
masque actif, avec éventuellement ceux
utilisés pour d'autres diapositives de la méme
présentation si celle-ci en utilise plusieurs.

2. Consulter la liste des pages maitresses
répertoriées dans la catégorie Utilisées dans
cette présentation et repérer celle qui est
sélectionnée.

Changer de masque depuis le volet
Taches

Affichez le volet des Pages maitresses, puis
sélectionnez, en mode Normal ou Trieuse de
diapositives les diapositives dont vous voulez
changer le masque.

- Si le nouveau masque a appliquer se trouve
affiché dans la catégorie (panneau) Ultilisés

dans cette présentation, il sera appliqué
uniquement aux diapositives sélectionnées. On
peut renoncer a ce comportement par défaut en
recourant & des commandes contextuelles du
modéle qui permettent d'étendre son application
a toutes les diapositives de la présentation.

- Si le nouveau masque a appliquer se trouve
dans les catégories Récemment utilisées ou
Disponibles pour ['utilisation il sera, par défaut,
systématiquement appliqué a toutes les
diapositives de la présentation. Un menu
contextuel permet toutefois de restreindre son
application aux seules diapositives
sélectionnées.

Changer de masque depuis la boite Style
de diapo

En mode daffichage Normal, la commande
Format > Conception de diapo ... ou le bouton
Conception de diapo dans la barre d'outils
Présentation ouvrent tous deux la boite de
dialogue Style de diapo.

Style de diapo |z|
Sélectionnez un style de diapo
Standard
[ Echanger la page d'arriére-plan Charger. ..
[1 supprimer les arriére-plans inutiisés

Celle-ci affiche les masques utilisés dans la
présentation active, et celui attaché a la diapo en
cours se trouve sélectionné.

— Pour changer le masque attaché a la diapo
active uniquement, en sélectionner un autre
dans la boite (ou en charger un autre) puis bien
vérifier que l'option Echanger la page d'arriére-
plan n'est pas cochée avant de valider la
commande.

— Pour changer le masque attaché a la diapo
active ET répercuter le changement sur les
autres diapos qui partagent le méme masque,
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cocher l'option Echanger la page d'arriére-plan
avant de valider la commande.

Le bouton Charger... permet de récupérer un
nouveau masque a partir de modeéles enregistrés
sur le disque dur, sous l'une des catégories Mes
modeles, Arriere-plans de présentation ou
Présentations. Les masques récupérés de la
sorte apparaissent alors dans le volet Pages
maitresses, dans le panneau Disponibles pour
l'utilisation.

L'option Supprimer les arriere-plans inutilisés
permet de supprimer dans la boite les masques
qui ne sont affectés a aucune des diapositives de
la présentation.

La suppression des masques inutilisés dans cette
boite de dialogue n'est pas répercutée dans le volet
Pages maitresses du volet des Téches ou de la barre
latérale (dans le cas de AOO 4.0).

Modifier un masque

On peut modifier un masque aprés l'avoir affiché
en mode Masque pour le déverrouiller et rendre
accessibles ses propriétés et éléments internes :
couleur ou image d'arriéere-plan, objets graphiques
(logo, par exemple), taille, position et contenu des
en-tétes et pieds de page, etc.

La modification des formatage des textes et objets
présents dans le masque se fera de préférence par
modification des styles correspondants dans le
Styliste.

1. Basculez en mode Masque par la commande
Affichage > Masque > Masque des diapos.
La barre d'outils Mode Masque apparait.

2. Dans la liste des pages maitresses du volet
Taches, cliquez sur celle a modifier pour la
faire apparaitre dans le volet Diapos listant les
pages maitresses actives dans la présentation.

3. Effectuez les maodifications souhaitées, puis
quittez le mode masque en cliquant sur le
bouton Fermer le mode Masque.

4. Enregistrez le fichier avant de continuer.

Les modifications apportées a un masque sont
automatiguement répercutées a toutes les
diapositives de la présentation qui lui sont liées.

On peut utiliser cette technique pour ajouter une
boite de texte avec un contenu a reproduire en en-
téte ou pied de page dans toutes les diapositives
liées a un masque.

Créer un nouveau masque

Vous pouvez, & tout moment, créer un nouveau
masque et le mettre a disposition de la
présentation active.

On peut, par exemple, créer un masque différent
intégrant un cadre destiné a énoncer des
conclusions spécifiques a une partie de I'exposé,
afin de mieux les faire ressortir.

Pour ce faire :

1. Basculez en mode de travail Masque par la
commande Affichage > Masque - Masque
des diapos, ou a partir de la commande
contextuelle Editer le masque d'une page
maitresse sélectionnée dans le panneau
Utilisées dans cette présentation du volet
Pages maitresses.

2. La barre d'outils Mode Masque apparait.

3. Cliqguez sur le premier bouton de la barre,
intitulé Nouveau masque.

4. Un nouveau masque standard se rajoute dans
le volet Diapos.

5. Modifiez-le pour obtenir ce que vous
souhaitez, puis renommez-le en cliquant a
droite sur sa miniature dans le volet Diapo et
choisissez la commande  contextuelle
Renommer le masque.

6. Une fois votre travail terminé, fermez la barre
d'outils du mode Masque pour revenir au mode
d'affichage Normal.

I ne vous reste plus qu'a lier votre nouveau
masque a des diapositives de la présentation.

4.9. Le Styliste

La commande Format > Styles et formatage
(F11) ouvre la boite Styles et formatage, appelée
aussi Styliste, permettant de gérer les deux
catégories de styles disponibles dans Impress :
styles d'images et styles de présentation,
disposant chacun de leur propre boite de
modification.

Dans AOO 4.0, vous pouvez également accéder au
Styliste depuis la barre latérale.

Les boites de dialogue de définition et de
modifications des styles de présentation et
d'images possédent 5 onglets communs ; ce sont
ceux dédiés au formatage de texte. Par contre,
ces boites ne renferment aucun onglet permettant
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4.Finaliser une présentation

de définir la position du texte, il faut recourir a la
boite Format > Caractéres > Position pour
accéder a ces options qui gerent la position du
texte par rapport a la ligne de base lors de
I'insertion de caractéres en exposant ou indice.

Les styles affichés sont ceux appliqués a la
diapositive active et ils sont hérités du masque
auquel elle est liée.

Dans le cas d'une présentation utilisant plusieurs
masques :

- Les styles de présentation sont spécifiques a
chaque masque utilisé. Ainsi, par exemple, le
style Titre sera appliqué a chaque diapositive
liée au masque et permettra d'assurer un
contraste de couleur permettant une lecture
optimale du texte. Il en sera de méme des styles
Plan 1 a 9 automatiquement appligués aux
différents niveaux de plan des textes saisis dans
les espaces réservés de texte.

—Les styles d'images sont communs et
appliqués de facon uniforme aux objets insérés
et a leurs contenus texte, s'il y en a, comme
dans le cas dimages ou de boites de texte
insérées manuellement.

Les styles d'image

Styles et formatage E
Corps de texte

Corps de texte justifié
Ligne de cote

Objet avec fléche
Objet avec ombre
Objet sans remplissage
Retrait de premiére ligne
Standard

Texte

Titre

Titrel

Titre2

Titre3

Titred

Titre5

Tous les styles El

Comme leur nom le suggére, ces styles
définissent les caractéristiques des objets
graphigues insérés dans les diapositives (y

compris leurs contenus texte) : boites de texte,
formes et connecteurs. Les styles de texte
présents dans cette catégorie de styles sont ceux
qui gérent l'apparence des textes intégrés dans
les boites de texte, les formes et les images.

Vous pouvez créer dans cette catégorie de
nouveaux styles personnalisés a partir de boites
de texte ou d'images formatées manuellement ou
les créer directement a l'aide de la boite de
définition des styles d'images.

Vous pouvez de méme modifier des styles
d'origine, mais pas les supprimer.

Les styles d'images sont communs a Draw et

Impress.
Styes dimages Standerd T [ -
Gérer |Ligne | |Ombrage | Transparer |Po|ice | Effets de é | Retraits et |

Texte | Animationdetexte | Cotation | Connecteur | Alignement | Tabulations

Texte

Ad__a_[_;_tg[ la largeur au texte: I} [ Renvoyer le texte a la ligne dans la forme

Adapter la hauteur au texte [7] Adapter la forme au texte
[J Adapter au cadre

[ Ajuster au contour

Espacement avec les bordures Ancre de texte

Gauche 0.25cm K

Droite 0.25cm El l ™ l
Haut 0.13cm l J
- E Pleine largeur

\ [ ok ][ annuter || Aide_” Rétablir H§:a'nda|ﬂ

Les caractéristiques de base de ce type de style
sont toutes réparties dans les onglets de la boite
des styles graphiques représentée ci-dessus, et
définissent le style d'image Standard.

Onglet Gérer

Il permet de nommer le style et de désigner son
style parent dans la liste Lié a. Il renferme un
résumé de tous les parameétres inclus dans le
style.

Chaque style d'image contrdle la mise en forme
des trois principales caractéristiques d'un objet
graphique : lignes, surfaces et textes.

Onglet Ligne

C'est la que vous pouvez définir I'apparence des
lignes et des fleches pour des schémas. Vous
disposez de 12 styles de ligne allant de invisible a
ligne continue ou a pointillés, ainsi qu'un
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4. Finaliser une présentation

assortiment de fleches ou de fins de ligne. Vous
pouvez définir aussi ici une épaisseur de ligne.

Styles diimages: Standand

Retraits ek espacement Texte Animation de texte Cotation | Conneckeur || Alignement
Tabulations
GErer | Ligne | Remplissage Ombrage Transparence Police Effets de carackéres

Propriétés de |3 ligne Styles de fleche

Style Shvle

— ‘Eantint) v | |- aucunie)- v ‘ | aucunie;- L
Couleur Largeur

|I:| Gtis v | 0.20cm 0.20crm

Largeur Zenkre Centre
|D‘00cm = | [ Synchroniser les sxtrémités

Transparence Styles d'angle et painte

IU% - | Skyle d'angle Style de pointe

|Am:|r|di b4 ‘ |Plat ha

[ 0K ][ Annuler ][ Aide ][ Rétablir H Standard

Onglet Remplissage

Il permet de choisir entre un remplissage coloré
uni, un dégradé, une hachures ou une image.
Sélectionnez une de ces options dans le menu
déroulant, pour voir s'afficher les options
correspondantes.

Onglet Ombrage
Permet d'ajouter une ombre portée a l'objet.

Onglet transparence

Il permet de définir non seulement le pourcentage
de transparence d'un objet, mais permet aussi de
créer un degré de transparence variable
(gradient).

Onglet Connecteur

Pour montrer les relations entre des objets, par
exemple les boites d'un arbre généalogique ou
d'un organigramme, on fait appel a [l'outil
Connecteur dans la barre d'outils Dessin pour les
relier. Un connecteur peut étre positionné le long
du bord d'un objet, et sa taille et sa forme
s'adaptent lorsque les objets reliés sont déplacés.

L'onglet Connecteur vous permet de les modifier :
changer le type de connecteur de droit a courbe,
régler l'angle, etc. Ces modifications sont alors
automatiquement répercutées a tous les
connecteurs qui utilisent le méme style.

Styles d'images: Standard | X |

Tabulations
Gérer || Ligne || Remplissage Ombrage || Transparence || Police | Effets de caractéres
Retraits et espacement || Texte ” Animation de kexte ” Cotation |EDnnecteur ‘ Alignement.

Type

Décalage de ligne

Ligre 1

Interligne

Début horizantal
Début vertical

Fin hotizontale

Fin werticale 0.50cm =

L 0K I[ Annuler J[ Aide J[ FRétablir J[ Standard }

Les caractéristiques de texte

Elles se définissent dans plusieurs onglets et sont
trés similaires a celles rencontrées dans Writer ou
Calc, mais avec une différence notoire. Ici, les
parametres ne se réferent pas au texte ordinaire,
mais au texte saisi dans les objets graphiques,
telles que les boites de texte créées avec l'outil
Texte de la barre Dessin.

Les styles de présentation

Styles et formatage E

Arriere-plars
Notes
Objets d'arriére-plan
Plan 1

Plan 2

Plan 3

Plan 4

Plan 5

Plan &

Plan 7

Plan 8

Plan 9@
Sous-titre
Titre

Tous les styles IEI

lls définissent l'apparence des trois éléments
suivants d'une page maitresse : l'arriére-plan, les
objets d'arriere-plan (icones, lignes décoratives et
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cadres de texte) et le texte saisi dans les espaces
réservés de texte ou les cadres des notes.

Les styles de texte se répartissent comme suit :
Notes, Plan 1 a Plan 9, Sous-titre et Titre. Ce sont
les seuls styles accessibles depuis le Styliste en
mode Plan. La liste est fixe, il n'est pas possible
d'en créer des nouveaux, mais on peut modifier
les styles existants.

Les autres styles de cette catégorie définissent
I'apparence de l'arriere-plan et des objets qui s'y
trouvent (objets graphiques décoratifs, etc.).

— Arriére-plan : désigne le fond de la diapositive,
sans objet de décoration. On peut accéder a
ses propriétés par la commande Format >
Page... - Arriére-plan.

— Notes : style appliqué au texte saisi dans la
zone d'édition de texte du mode d'affichage
Notes. On peut le modifier par l'intermédiaire du
masque des notes.

— Objets d’arriére-plan : style des objets qui
seront créés dans le masque des diapos.

—Plan 1 & Plan 9 : niveaux hiérarchiques avec
leurs puces.

— Sous-Titre : utilisé uniquement dans Ila
diapositive de titre

— Titre : titre des diapositives.
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Ce chapitre aborde les principaux modes
d'utilisation possibles d'une présentation.

5.1. Projection sur écran
C'est l'utilisation la plus classique, le diaporama

sert alors d'appui a une présentation orale. On
charge la présentation sur un ordinateur connecté

a un vidéo-projecteur et on lance le diaporama.

Démarrer la projection

Pour lancer la projection depuis la diapositive
courante, utilisez I'une des procédures suivantes :

— Cliquez sur le bouton Diaporama dans les
barres d'outils Présentation, Plan (en mode
Plan) et Trieuse de diapositives.

—Lancez la commande Diaporama >
Diaporama, depuis la barre des menus.

— Utilisez les raccourcis-clavier F5 ou F9.
Naviguer entre les diapositives

Pour passer d'une diapositive a l'autre :

- Si la transition des diapos est définie sur
Automatiquement aprés x secondes, laissez le
diaporama se dérouler tout seul.

- Si la transition des diapos est définie sur Au clic
de la souris (option par défaut), effectuez l'une
des procédures suivantes pour passer d'une
diapo a l'autre :

x Utilisez la touche de navigation Fléche
droite, la touche Enter, la barre
d'espacement, ou un clic gauche avec la
souris  pour passer a la diapositive
suivante.

x Utilisez la touche de navigation Fléche
gauche, ou la touche Backspace, pour
revenir a la diapositive précédente.

x La touche Home renvoie a la premiéere
diapo et la touche End a la derniére.

Lorsque vous arrivez a la derniére diapo, le
message "Cliquez pour quitter la présentation..."
apparait. Vous pouvez alors cliquer avec la souris
ou appuyer sur n'importe quelle touche du clavier
pour quitter la présentation.

Vous pouvez quitter la présentation a tout moment,
y compris a la fin, en appuyant sur la touche
Escape.

Utiliser le Navigateur

[ Suivante
4 Précédente
Accéder a la diapo »

Pointeur souris en stylo

Largeur du stylo »
Maodifier la couleur du stylo
Effacer tout le stylo de la diapo

Ecran b

Fin du diaporama
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5.Utiliser une présentation

En cours de projection, lorsqu'on clique sur le
bouton droit de la souris, un menu contextuel
appelé Navigateur, propose des commandes de
navigation pour atteindre la diapositive suivante,
la précédente ou encore n'importe quelle autre
diapositive choisie dans la liste Accéder a la
diapo.

Un stylo paramétrable et une gomme sont
€galement disponibles pour réaliser des
annotations.

Paramétrer la projection

La commande Diaporama > Paramétres du
diaporama ouvre une boite permettant de
définir des options de projection.

Plage

Cette rubrique permet d'indiquer si le diaporama
doit étre intégralement projeté, ou seulement
démarré a partir d'une diapositive donnée. On

peut également projeter un diaporama
personnalisé.
[ Diaporama S0
Pli;fruutes les diapos: [—]OK
© A partir de : Diapo 1 E‘ Annuler
Diaporama personnalisé

[

Type Options
® Par défaut Transition manuelle

© Fenétre Pointeur visible NS

© Auto Pointeur crayon

00:00:10 5

[ Afficher le logo

Navigateur visible
Autoriser les animations
Transition par clic sur I'arriére-plan

Présentation toujours au premier plan

Ecrans multiples

Ecran de présentation D‘

Type

— Par défaut : la projection utilise tout I'espace
écran disponible.

— Fenétre : projection dans une fenétre.

- Auto diaporama  automatique, avec
redémarrage en boucle. Dans ce cas, il faut
spécifier la période de pause a adopter entre
deux projections successives. On peut aussi
décider si on affiche le logo OO.org ou pas.

— Options permet de décider ou non de
I'affichage du pointeur et de décider d'autoriser

ou non l'exécution des animations. On peut
également choisir d'exécuter manuellement ou
pas les transitions automatiques définies pour
les diapositives, s'il y en a.

Chronométrer la présentation

La commande Diaporama > Présentation
chronométrée permet de chronométrer le temps
nécessaire a la présentation. Elle démarre la
projection et affiche un chrono en bas a gauche
de I'écran.

—Si une animation démarre par un clic, le
chronomeétre se lance aprés l'animation pour
permettre de la jouer sans que sa durée
d'exécution ne soit comptée dans la durée
d'exposition de la diapositive qui la contient.

— Lorsque vous avez terminé le commentaire
d'une diapositive, passez simplement a la
suivante en cliquant, non pas sur la diapositive
pour transiter vers la suivante, mais directement
sur le chrono: celui-ci est remis a zéro et
mesure alors la durée d'exposition nécessaire
pour la nouvelle diapositive projetée a I'écran.

— Enregistrez votre présentation pour conserver
ces valeurs mesurées et pouvoir les utiliser
ultérieurement lors de la projection qui
s'exécutera alors de fagon automatique.

Pour annuler le chronométrage d'une présentation,
paramétrez les transitions de toutes ses diapos "Au
clic" dans l'onglet Transition du volet Taches et
enregistrez-la.

Présentation personnalisée

La commande Diaporama > Diaporama
personnalisé... permet de créer des variantes
n'intégrant qu'une partie des diapositives de la
présentation initiale. Il suffit alors de choisir dans
la liste celle qui semble la mieux adaptée au
public cible.

La boite Diaporamas personnalisés

Cette boite permet a tout moment :

— D'éditer l'une des présentations personnalisées
existantes.

—De créer une nouvelle présentation
personnalisée en cliquant sur le bouton
Nouveau ....

— De supprimer I'une des présentations de la liste.

© 2012 - 2013 G. Waterval

Version : 26/04/13

Apache licence, Version 2.0

0004Kids - Apache OpenOffice™ - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

55/64



http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr
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— De lancer une présentation de la liste si vous
avez coché [l'option Utiliser le diaporama
personnalisé. Si cette option n'est pas cochée,
c'est la présentation mére qui est lancée.

Créer une présentation personnalisée

La création d'une présentation personnalisée se
fait en choisissant les diapos qui en feront partie
dans la boite de dialogue ci-dessous, puis en
attribuant un nom a la nouvelle présentation.

Cette boite apparait lorsqu'on clique sur le bouton

Nouveau ... dans la boite Diaporamas
personnalisés.
CTTY T TR — -
|
Nom ‘Nuuveau diaporama personnalisé ‘ OK
Diapos existantes Diapos sélectionnées
Diapo 1
Diapo 2 E
bt
Diapo 6
be

On utilise les deux boutons fléchés au centre de
la boite pour générer la liste des pages a intégrer
dans la présentation personnalisée. Il reste alors
a nommer le diaporama personnalisé créé avant
de valider en cliquant sur le bouton OK.

5.2. Apercu dans le navigateur

La commande Fichier > Apercu dans le
navigateur Web visualise la présentation dans le
navigateur Web par défaut.

Une série de liens permettent de naviguer entre
les diapositives et un lien intitulé Texte permet
d'afficher uniquement le texte de la diapositive
courante.

Premiére page Précédent Sumivant Dermiére page Texie

Lorsque le texte de la diapositive est affiché, un
lien Images permet de revenir a l'affichage normal
dans le navigateur.

5.3. Exporter au format Flash

On peut convertir une présentation au format
Macromedia Flash (format .SWF) avant de
I'envoyer sur Internet ou Intranet.

La procédure est la suivante :

— Lancer la commande Fichier > Exporter ...

— Choisir I'endroit de stockage, le type et le nom
du fichier.

— Sous Type, choisir Macromedia Flash (.swf)
puis cliquer sur Enregistrer.

La lecture d'une présentation dans ce format peut
se faire dans la fenétre d'un navigateur équipé du
plugin adéquat. La présentation défile par clic sur
I'écran et peut étre lue en boucle.

Par contre, les transitions, les sons et les
animations ne sont pas exportés.

Vous pouvez télécharger Adobe Flash player ici :
http://www.adobe.com/products/flashplayer/

5.4. Exporter au format HTML

Vous pouvez exporter vos présentations sous
forme de pages web pour les rendre accessibles
sur Internet ou Intranet au travers d'un navigateur.
L'internaute peut alors en parcourir les pages en
cliquant sur des boutons fléchés, un peu comme
sur un lecteur de CD (avancer, reculer, revenir au
début, etc.), mais les animations ne sont pas
supportées.

La procédure d'exportation convertit chaque
diapositive en une image dans un format
compressé et crée un fichier HTML qui permet
d'afficher les diapos sous forme d'images dans le
navigateur, chaque image étant accompagnée de
liens de navigation Précédent et Suivant.

Procédure d'exportation :

1. Commencez par créer un répertoire de
sauvegarde dédié pour les fichiers résultant de
I'exportation.

2. Lancez la commande Fichier > Exporter ... et
choisissez Document HTML (OpenOffice.org
Impress) comme type de fichier, et le répertoire
créé a l'étape précédente comme dossier de
destination. Donnez un nom & votre
exportation avant de cliquer sur le bouton
Enregistrer.

3. Un assistant d'exportation démarre pour vous
aider a paramétrer I'exportation. Les étapes a
parcourir ne seront pas les mémes selon le
type de publication que vous déciderez
d'adopter a I'étape 2 de l'assistant. A la sortie
de cet assistant, I'exportation est réalisée et
une page dindex est créée avec des
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hyperliens pointant sur les différentes pages
HTML de la présentation. C'est sur cette page,
qui porte le nom donné a l'exportation, qu'il
faudra double cliquer pour démarrer la
projection.

Nous allons maintenant détailler les différentes
étapes proposées par l'assistant pour une
exportation au format HTML standard.

Etape 1: design des pages

Choisissez le design de vos pages, a partir d'un
design existant, ou créez-en un pour l'occasion
par l'option Nouveau design. Tout nouveau design
s'intégre dans une liste et peut étre réutilisé par la
suite.

Si vous ne disposez pas d'un design prédéfini,
I'option Design existant n'est pas accessible.

Pour passer a l'étape suivante, cliguez sur le
bouton Suivant>>.

Etape 2: type de page Web

Au cours de cette étape, vous devez choisir le
type de page Web a créer. Vous avez également
la possibilité de créer une page de garde et
d'afficher les notes, si vous le souhaitez.

- Format HTML standard une page par
diapositive, avec des liens pour passer de l'une
a l'autre.

— Format HTML standard avec cadres : une
page avec une barre de navigation sur le coté
gauche, utilisant le titre de chaque page comme
lien de navigation. Cliquer sur les liens pour
afficher les pages dans le volet de droite.

— Automatique : une page par diapo, avec un lien
pour passer a la page suivante. Ce type de
publication aboutit a une présentation qui
défilera automatiquement, la transition d'une
diapositive a la suivante se faisant comme défini
dans le document ou en automatique apres un
temps de pause qu'il faut alors définir.

— WebCast : crée une application ASP ou Perl
pour afficher les diapos.

Etape 3 : format des images

Choisir le format de sauvegarde des images
(PNG, GIF or JPG) ainsi que leur taux de
compression.

Vous disposez également d'options pour exporter
les sons et les diapositives masquées.

Lorsque vous choisissez une résolution d'écran pour
la présentation exportée, tenez compte du matériel
dont la majorité des gens disposent. Si vous utilisez
une haute résolution, alors une personne disposant
d'un moniteur de résolution moyenne devra scroller
pour afficher les pages en entier sur son écran, ce
qui n'est pas tres agréable.

Etape 4 : page de titre

Si vous avez décidé, lors de I'étape 2, de créer
une page de garde, il faut maintenant la
compléter.

Cette page de titre doit renfermer le nom de
l'auteur de la composition, son adresse e-mail,
ainsi qu'un lien pointant vers la présentation
originale et dautres informations que vous
souhaiteriez ajouter.

Etape 5 : outils de navigation

Permet de choisir entre des liens hypertextes ou
des boutons comme outils de navigation dans la
présentation exportée. Si ce sont des boutons,
vous pouvez choisir ici leur style.

Etape 6 : schéma de couleurs

Sélectionnez un schéma de couleurs pour les
pages web. Les schémas utilisables incluent le
schéma existant pour le document, un autre basé
sur les couleurs du navigateur, et un troisieme
complétement défini par l'utilisateur.

Vous pouvez sauvegarder un nouveau schéma de
telle sorte qu'il apparaisse lors de la premiere
étape de l'assistant d'exportation au format
HTML.

Etape 7 : démarrer
I'exportation
Cliquez sur Créer pour générer les fichiers HTML.

Si vous utilisez un nouveau design, une petite
boite apparait pour vous permettre, si vous
souhaitez le réutiliser, de lui donner un nom. Dans
le cas contraire, cliquez sur le bouton Ne pas
enregistrer.
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5.Utiliser une présentation

5.5. Exporter au format PDF

OpenOffice peut exporter ses différents
documents au format PDF (Portable Document
Format) pour les rendre accessibles en lecture
sur tout systéme intégrant un lecteur de fichiers
PDF.

Deux commandes permettent de réaliser cette
exportation :

— Le bouton “% Export direct au format PDF,
situé dans la barre d'outils Standard réalise
I'exportation avec les options par défaut. Une
boite d'enregistrement s'ouvre pour permettre
d'attribuer un nom au fichier et d'indiquer son
répertoire de sauvegarde.

— La commande Fichier > Exporter au format
PDF ... ouvre la boite de dialogue Options PDF,
dont les 5 onglets permettent de paramétrer le
contenu et la qualité du fichier PDF créé. Une
fois le paramétrage effectué, il suffit de cliquer
sur le bouton Exporter, puis d'indiquer un nom
et un endroit de sauvegarde pour le fichier PDF
créé.

Si vous installez I'extension pdfimport.oxt, vous
disposerez d'une option d'exportation
supplémentaire, sous forme de fichier PDF hybride.
Un tel fichier s'ouvre de maniere classique dans un
lecteur PDF, mais il est aussi éditable dans
OpenOffice.

5.6. Envoyer par Email

La commande Fichier > Envoyer > Document
par E-mail ... se charge d'ouvrir votre logiciel de
messagerie pour l'envoi d'un nouveau message
avec la présentation comme fichier attaché.

5.7. Exporter des éléments

Il est possible d'exporter dans un fichier une
diapositive compléte, ou seulement certains de
ses contenus, sous différents formats. En fonction
du format choisi, une boite s'ouvre pour proposer
les options d'exportation correspondantes.

Ainsi, si on exporte une page comme image au
format JPG, on pourra choisir son niveau de
compression et donc la qualité du tirage.

Procéder comme suit :
1. Affichez la page en mode Normal, puis lancez

la commande Fichier > Exporter..., et

choisissez le format d'exportation souhaité
dans la liste déroulante Type. Donnez un nom
au fichier puis validez en cliquant sur le bouton
Enregistrer.

2. Au besoin, définissez vos options d'exportation
dans la boite de dialogue qui s'ouvre, puis
validez I'exportation par OK.

Pour exporter une image, la sélectionner en mode
Normal, puis choisir sa commande contextuelle
Enregistrer comme image ....

5.8. Imprimer une présentation

OpenOffice Impress dispose de deux commandes
d'impression :

- Le bouton Impression rapide ™', dans la
barre d'outils Standard, imprime
systématiquement toutes les pages de la
présentation, avec les options actives dans la
boite de configuration d'impression.

— La commande Fichier > Imprimer ... (Ctrl+P)
ouvre la boite de dialogue Imprimer qui permet
de redéfinir certaines options, mais uniquement
pour le document en cours. On peut ainsi
obtenir limpression de certaines pages
uniguement, ou de certains contenus.

Avant de lancer une commande d'impression, lancez
la commande Format > Page... pour sélectionner
I'orientation  Portrait ou Paysage des pages
d'impression et définir leurs marges.

Avec OOolLight et O0O04Kids

Les options d'impression

Options d'impression m . ._—
Qualité
@ Par défaut
@ Niveaux de gris
@ Moir et blanc
Imprimer Options de la page
[F] Nom de la page @ Standard
[C] pate © Adapter au format de la page
ﬂaure ® Pages en mosaique
Pages masquées © Brachure
& Page recto | Page verso
Bac d'aprés les paramétres de limprimante

Dans la boite d'impression, un clic sur le bouton
Options ... ouvre la boite des options
d'impression. Celle-ci permet de spécifier les
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5.Utiliser une présentation

N

contenus a imprimer, la qualité d'impression
désirée, ainsi que des options de page.

Les options d'impression d'un document sont
sauvegardées avec lui. Mais pour pouvoir les
utiliser par la suite, il faut que l'option Charger les
paramétres de I'imprimante avec le document soit
cochée dans la commande Outils > Options >
Chargement-Enregistrement > Général.

Imprimer les Diapositives

Choisir I'option "Diapos" dans la liste déroulante
Contenu, puis indiquer les pages a imprimer dans
la rubrique Zone d'impression, ainsi que le
nombre d'exemplaires souhaités.

— Toutes les pages : imprime toutes les pages de
la présentation.

— Pages : utilisez le tiret pour définir les séries de
diapos a imprimer et des virgules ou points
virgules pour séparer les séries entre elles, par
exemple: 1, 5, 11-14, 34-40.

— Sélection imprime une sélection dans la
diapositive courante, par exemple une image.

Imprimer le Plan

Choisir l'option "Plan" dans la liste déroulante
Contenu, puis indiquer les pages a imprimer dans
la rubrique Zone d'impression, et le nombre
d'exemplaires souhaités.

Imprimer les Notes

.
JE—— uj]

Imprimante

Nom Microsoft XPS Document Writer E” l Propriétés... I

Etat Imprimante par défaut; Disponible
Type Microsoft XPS Document Writer
Emplacement XPSPort:

Commentaire

Imprimer dans un fichier

Imprimer le contenu

Diapos par page

Ordre @ Horizontal
Vertical

Zone d'impression ——————————— Exemplaires

@ Toutes les pages MNombre d'exemplaires

S
053 N-H [¥] Assembler

Sélection 12 12

T |

.

Choisir l'option "Notes" dans la liste déroulante
Contenu, puis indiquer les pages a imprimer dans

la rubrigue Zone d'impression, et le nombre
d'exemplaires souhaités.

Imprimer un Prospectus

L'impression d'un Prospectus fournit un résumé
de la présentation sous forme de pages
imprimées. Lorsqu'on choisit d'imprimer ce type
de contenu, la boite fait apparaitre des options
supplémentaires.

Imprimer le contenu

Contenu

Diapos par page

Horizontal

Ordre

@ Vertical

Il reste alors a définir le nombre de diapos a
afficher par page ainsi que l'ordre dans lequel
elles seront placées (de gauche a droite puis vers
le bas ou de haut en bas puis vers la droite) avant
de valider la commande d'impression.

Imprimer une Brochure

Il est possible d'imprimer une présentation recto
verso sous forme de livret (brochure) au format
A6 avec deux diapos sur chaque face des feuilles
d'impression, de telle sorte qu'au final, le nombre
de pages soit réduit de moitié.

Procédez comme suit :

1. Dans la boite Impression, vérifiez les réglages
de votre imprimante (orientation des pages
d'impression en Paysage) en cliquant sur le
bouton Propriétés ...

2. De retour dans la boite d'impression, cliquez
sur le bouton Options ... pour accéder a la
boite Options d'impression, puis cochez
I'option Brochure.

3. Si votre imprimante est capable d'imprimer en
recto verso, cochez a la fois les options Page
recto et Page verso. Si ce n'est pas le cas,
procédez en deux temps. Commencez par
imprimer uniquement les Pages verso, puis
replacez les pages imprimées dans le bac de
I'imprimante en les orientant correctement de
maniére a pouvoir imprimer uniquement les
Pages recto.
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5.Utiliser une présentation

Avec Apache OpenOffice (AOO)

Les options d'impression

Dans la boite diimpression, c'est [l'onglet
OpenOffice Impress qui fournit les diverses
options d'impression. Il permet de spécifier les

contenus a imprimer, la qualit¢ et la taille
d'impression souhaitées.

OpenOffice.org Impress |Mise en page |Opti0ns |

Contenu

1 Nom de la diapo
[[] Date et heure

[C] Pages masquées

Couleur
@ Couleurs d'origine
@ Niveaux de gris

© Noir et blanc

Taille
@ Taille d'origine
© Adapter & la page imprimable
© Répartir sur plusieurs feuilles de papier

© Juxtaposer des diapos répétées sur la feuille de papier

Les options de page sont regroupées dans
I'onglet Mise en page représenté ci-dessous. On
peut décider ici du nombre de diapos, pages de
prospectus ou pages de notes a faire apparaitre
une sur méme page d'impression, ou encore
d'imprimer la présentation sous forme de
brochure.

|Généra| | OpenOffice.org Impress |Mise en page |Options

Mise en page

® Pages par feuille |1 |ZI
Ordre |de gauche & droite, puis en bas EI 1

Dessiner une bordure autour de chaque page

@ Brochure

Cotés des pages

Inclure |Toutes les pages El

Les options d'impression d'un document sont
sauvegardées avec lui. Mais pour pouvoir les
utiliser par la suite, il faut que l'option Charger les
parameétres de l'imprimante avec le document soit

cochée dans la commande Outils > Options >
Chargement-Enregistrement > Général.

Imprimer les Diapositives

Choisir 'option "Diapos" dans la liste déroulante
Document de l'onglet Général, puis indiquez les

diapos a imprimer ainsi que le nombre
d'exemplaires souhaités.

— Toutes les diapos : imprime toutes les pages de
la présentation.

— Diapos : utilisez le tiret pour définir les séries de
diapos a imprimer et des virgules ou points
virgules pour séparer les séries entre elles, par
exemple: 1, 5, 11-14, 34-40.

— Sélection imprime une sélection dans la
diapositive courante, par exemple une image.

Dans l'onglet Mise en page, indiquez le nombre
de diapos a imprimer par page d'impression.

Imprimer le Plan

Choisir l'option "Plan" dans la liste déroulante
Document de l'onglet Général, puis indiquer les
pages a imprimer, ainsi que le nombre
d'exemplaires souhaités, comme au point
précédent.

Dans l'onglet Mise en page, indiquez le nombre
de diapos a imprimer par page d'impression.

Imprimer les Notes

Choisir l'option "Notes" dans la liste déroulante
Document de l'onglet Général, puis indiquer les
pages a imprimer dans la rubrique ainsi que le
nombre d'exemplaires souhaités.

Dans l'onglet Mise en page, indiquez le nombre
de diapos a imprimer par page d'impression.

Imprimer un Prospectus

L'impression d'un Prospectus fournit un résumé
de la présentation sous forme de pages
imprimées. Lorsqu'on choisit d'imprimer ce type
de contenu, la boite fait apparaitre des options
supplémentaires.
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5.Utiliser une présentation

Plage et exemplaires

® Toutes les diapos Nombre d'exemplaires
© Diapos |1-11 [] Assembler ﬁﬁ ﬁﬁ
® Sélection N

Imprimer dans I'ordre inverse

Imprimer

Document Pr sp

Diapos par page |Par défaut :l Ordre |De gauche & droite puis vers le basEl

Il reste alors a définir le nombre de diapos a
afficher par page ainsi que l'ordre dans lequel il
faut les y mettre (de gauche a droite puis vers le
bas ou de haut en bas puis vers la droite) avant
de valider la commande d'impression.

Imprimer une Brochure

Il est possible d'imprimer une présentation recto
verso sous forme de livret (brochure) au format
A6 avec deux diapos sur chaque face des feuilles
d'impression, de telle sorte qu'au final, le nombre
de pages soit réduit de moitié.

Procédez comme suit :

1. Dans la boite Impression, vérifiez les réglages
de votre imprimante (orientation des pages
d'impression en Paysage) en cliquant sur le
bouton Propriétés ...

2. De retour dans la boite d'impression, apres
avoir défini dans l'onglet Général ce que vous
souhaitez imprimer, activez l'onglet Mise en
page, puis cochez I'option Brochure.

3. Si votre imprimante est capable d'imprimer en
recto verso, choisissez Toutes les pages dans
la liste Inclure. Si ce n'est pas le cas, procédez
en deux temps. Commencez par imprimer
uniguement les Pages verso, puis replacez les
pages imprimées dans le bac de l'imprimante
en les orientant correctement de maniere a
pouvoir imprimer uniquement les Pages recto.

5.9. Créer un prospectus

La réalisation d'un prospectus permet de
distribuer au public une version imprimée de la
présentation, sous forme de pages affichant les
diapositives en réduction, avec éventuellement
des cadres vides pour permettre a l'utilisateur
d'ajouter des notes personnelles.

Pour réaliser un tel document il faut d'abord
basculer en mode d'affichage Prospectus en
cliguant sur le bouton Prospectus dans la barre

des Boutons de mode, ou en lancant la
commande Affichage > Page de prospectus,
puis choisir I'une des mises en pages disponibles
dans le volet Mises en page du volet Taches (ou
de la barre latérale avec AOO 4.0).

Modifier la page de prospectus

En haut et au bas de la page de prospectus, 4
rubriques prédéfinies dans le masque, intitulées
En-téte, Date et heure, Pied de page et Numéro
de page ne sont pas visibles, sauf si on demande
explicitement leur affichage par la commande
Affichage > Masque > Eléments du masque en
les cochant dans la boite de dialogue qui s'ouvre.
La commande Affichage > En-téte et pied de
page — Notes et prospectus, permet d'y insérer
des informations.

Les rubriques précédentes, lorsqu'elles sont
affichées dans la page de prospectus, ainsi que
les cadres vides correspondant aux diapositives,
peuvent alors étre redimensionnés et déplacés a
l'aide de la souris pour créer une mise en page
personnalisée ou éviter leur positionnement en
dehors de la zone imprimable.

Le redimensionnement des vignettes n'est possible
qu'apres avoir désactivé les options de protection
de leur position et de leur taille dans la boite
Position et taille.

Dans ce mode de travail, les outils de la barre
d'outils Dessin permettent également d'enrichir
les pages, en créant, par exemple, des cadres
vides destinés a recevoir les notes manuscrites
des utilisateurs.

Comme on travaille directement sur la page de
prospectus, ces enrichissement sont répercutés sur
toutes les pages du prospectus.

Le formatage des contenus texte peut se faire
manuellement, ou mieux, a l'aide de styles
d'images prédéfinis accessibles depuis le Styliste.

Imprimer le prospectus

Avant d'imprimer le prospectus, utilisez la
commande Format > Page... pour sélectionner
l'orientation Portrait ou Paysage des pages
d'impression et définir leurs marges.

Ensuite, lancez la commande Fichier > Imprimer,
puis choisissez "Prospectus" dans la liste
déroulante Document de I'onglet Général.
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5.Utiliser une présentation

On peut alors redéfinir le nombre de diapos a
afficher par page, ainsi que leur ordre, avant de
valider la commande d'impression.

5.10. Oracle Presenter screen

C'est une extension qui facilite le travail du
présentateur en projetant le diaporama sur un
second écran tout en lui affichant, sur son
ordinateur, un second écran non visible du public,
avec des fonctionnalités permettant de piloter le
diaporama tout en restant face au public pendant
la projection.

Cette extension ne peut fonctionner que si votre
systeme d'exploitation supporte les affichages
multiples. Ce qui suit a été testé sous Windows 7.0.

Les configurations préalables

1) Installez I'extension Oracle Presenter Console,
http://extensions.services.openoffice.org/project/p
resenter-screen puis relancez OpenOffice.

2) Branchez sur votre ordinateur le second écran
qui doit afficher le diaporama visible du public.

3) Dans le Panneau de configuration de Windows,
sous la rubrique Apparence et personnalisation,
cliguez sur le lien Modifier la résolution de
I'écran.

4) Dans l'écran de configuration représenté ci-
dessous, choisissez une Résolution, une
Orientation, puis l'option Etendre ces affichages
dans la liste Affichages multipes.

Modifier I'apparence de vos affichages

Diétecter

Identifier

Affichage :

Résalution: |2 Acer ALOT7 : |

Orientation : Payzage -

Affichages multiples : | Etendie ces aFfichages -

0 ='agit actuellernient de votre affichage principal. Paramétres avancés

Se connecter 3 un projecteur (ou appuyez sur la touche B et sur P)
Rendrne be texte et d'autres éléments plus petits ou plus grands

Quiels paramitres d'affichage chaisir 7

5) Validez vos choix en cliquant sur le bouton OK.

6) Chargez la présentation dans Impress puis
lancez la commande Diaporama > Parameétres

du diaporama
Diaporama s'ouvre.

7) Dans la liste Ecran de présentation choisissez
I'écran qui affichera le diaporama vu par le public.

La boite de dialogue

8) Démarrez le diaporama de maniére classique.

— L'écran de projection affiche le diaporama tel
gu'il est vu par le public.

— L'écran de l'ordinateur du présentateur affiche la
diapositive projetée, avec sur sa droite, la
diapositive suivante en réduction. Au bas de
I'écran une barre d'outils spéciale permet
d'accéder a la diapositive précédente ou
suivante et de basculer vers un mode
d'affichage Notes ou Slides. Cette barre affiche
également I'heure, ainsi que le temps écoulé
depuis le début de la projection. L'écran d'aide
affiche une liste de raccourcis clavier permettant
de manipuler le diaporama.

L'écran du présentateur
Par défaut, il affiche deux diapositives :

— Celle de gauche représente la diapositive
actuellement projetée.

— Celle de droite une réduction de la diapositive
suivante ou du prochain effet.

Dinstduinkarka

Pour naviguer entre les diapositives, utilisez :

— Les boutons fléchés dans la barre d'outils.

- Les touches fléchées de navigation gauche et
droite du clavier.

— Un clic gauche ou droit de souris, a condition
gue le pointeur de celle-ci soit positionné dans
un espace vide de I'écran, en dehors des zones
d'apercus des diapositives.
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5.Utiliser une présentation

La vue Notes

Lorsqu'une diapositive contient des notes, cliquez
sur le bouton Notes dans la barre d'outils pour
obtenir leur affichage dans un cadre sur la droite
de I'écran. La taille de police peut étre adaptée a
l'aide de deux boutons Zoom.

Curam Sen I8 E L Hedrr

La e national de la pdeha veut falre revivie la paasd
la cate Aama & la riche
W muse dans dea dbco abag mals anssl
vres dart, des illustrations iwers sléments

Dostdulnkerka
= i ct la culture du pé
L oecidantale”

Erédit : http: fvisiteur kaksijde. be/ product.
1989

......

Dans ce mode, la diapositive affichée est
représentée en réduction dans la partie
supérieure gauche de I'écran et la suivante en
dessous.

Pour revenir a I'affichage normal, 2 possibilités :

— Cliguer une nouvelle fois sur le bouton Notes
dans la barre d'outils.

— Cliquer sur le bouton Close au bas de la zone
d'affichage des notes.

La vue Slides

Elle affiche, dans la partie supérieure de I'écran,
les diapositives en réduction comme étalées sur
une table lumineuse. La diapositive projetée
apparait un peu plus grande que les autres.

Cette vue permet d'afficher au public toute

diapositive correspondant a la miniature sur
laguelle on clique.

Pour quitter cette vue et revenir a la vue normale,
cliquer sur le bouton Close ou une nouvelle fois
sur le bouton Slides dans la barre d'outils.

5.11. Créer des modeles

Vous pouvez utiliser une présentation existante
pour créer un modele de présentation et un ou
des modéles d'arriére plan.

Créer un modele de
présentation

Les modéles de présentation créés par l'utilisateur
ne sont rien dautre que des présentations
normales dans lesquelles la plupart des
diapositives ont été supprimées a l'exception de
celles qui sont réutilisables.

Généralement, on se limite a une diapositive de
titre et une diapositive normale disposant d'un
espace réservé de texte afin de ne conserver que
les éléments vraiment utiles a importer dans une
nouvelle présentation du méme genre : masque
de titre, masque de diapositive, avec
éventuellement I'effet de transition a appliquer aux
diapositives.

C'est donc cette présentation épurée qu'on
transforme en modéle en l'enregistrant par la
commande Fichier > Modéle de document >

Enregistrer, en choisissant la catégorie
Présentations.
Modéles z
Nouveau modéle de document: "
Mldélus | [ Snnde ]
Gathores Mo
hrvesius

La boite d'enregistrement se compose des
champs et commandes suivants :

— Nouveau modéle de document : champ de
saisie pour attribuer un nom au modele créé.

— Catégories : affiche la liste des catégories de
modeles. Sélectionnez la catégorie dans
laquelle  vous souhaitez  ranger votre
enregistrement. Au besoin, cliquez sur le bouton
Gérer... pour ouvrir la boite de gestion des
modéles et créer une nouvelle catégorie.

— Modéles : affiche la liste des modéles déja
contenus dans la catégorie sélectionnée.

- Bouton Editer : ouvre le modéle sélectionné
pour permettre son édition directe.
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— Bouton Gérer ... : ouvre la boite de dialogue
Gestion des modéles, dans laquelle vous
pouvez organiser vos modeles existants ou en
importer.

Créer un modele d'arriere plan

Vous pouvez utiliser les pages maitresses d'une
présentation active, c'est a dire celles classées
dans la catégorie Utilisées dans cette
présentation pour créer des modeles d'arriére-
plan réutilisables par la suite.

Mais pour cela, vous devez les déplacer dans la
catégorie Disponibles pour utilisation.

Un tel déplacement nécessite d'enregistrer la
présentation comme modéle, aprées l'avoir épurée
de maniére a ne conserver que le seul masque a
convertir en modéle d'arriere-plan. Une fois la
présentation épurée, il suffit de I'enregistrer
comme modéle par la commande Fichier >
Modéle de document > Enregistrer, en
choisissant la catégorie Arriéere-plans de
présentation.

Evitez d'enregistrer vos modéles dans la catégorie
Mes modeéles, sinon vous serez le seul a pouvoir y
accéder.
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